Verification of Laminar and Validation of Turbulent Pipe Flows

                 58:160 Intermediate Mechanics of Fluids
			                                   CFD LAB 1

By Timur Dogan, Michael Conger, Maysam Mousaviraad and Fred Stern
IIHR-Hydroscience & Engineering
The University of Iowa
C. Maxwell Stanley Hydraulics Laboratory
Iowa City, IA 52242-1585

1. Purpose 

The Purpose of CFD Lab 1 is to simulate steady laminar and turbulent pipe flow following the “CFD Process” by an interactive step-by-step approach. Students will have “hands-on” experiences using ANSYS to compute axial velocity profile, centerline velocity, centerline pressure, and friction factor. Students will conduct verification studies for friction factor and axial velocity profile of laminar pipe flows, including iterative error and grid uncertainties and effect of refinement ratio on verification. Students will validate turbulent pipe flow simulation using EFD data, analyze the differences between laminar and turbulent flows, and present results in CFD Lab report.
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2. Simulation Design

In CFD Lab 1, simulation will be conducted for laminar and turbulent pipe flows. Reynolds number is 655 for laminar flow and 111,569 for turbulent pipe flow, based on pipe diameter. The schematic of the problem and the parameters for the simulation are shown below.


Table 1 - Main particulars
	Parameter
	Unit
	Value

	Radius of Pipe
	m
	0.02619

	Diameter of Pipe
	m
	0.05238

	Length of the Pipe
	m
	7.62



        Outlet
Inlet
Symmetry Axis
Pipe Wall

Non-uniform Grid
Uniform Grid
Velocity Profile


Since the flow is axisymmetric we only need to solve the flow in a single plane from the centerline to the pipe wall. Boundary conditions need to be specified include inlet, outlet, wall, and axis, as will be described details later. Uniform flow was specified at inlet, the flow will reach the fully developed regions after a certain distance downstream. No-slip boundary condition will be used on the wall and constant pressure for outlet. Symmetric boundary condition will be applied on the pipe axis. Uniform grids will be used for the laminar flow whereas non-uniform grid will be used for the turbulent flow.




Table 2 - Grids
	Grid 
	 Grid Type
	# of Divisions

	
	
	X
	R

	8
	Uniform
	453
	45

	7
	
	320
	32

	6
	
	227
	23

	4
	
	113
	11

	3
	
	80
	8

	2
	
	57
	6

	0
	
	28
	3

	T
	Non-uniform 
	564
	15



Experimental, analytical and simulations will be compared. Additionally, detailed verification and validation study will be conducted. All the studies are detailed in the Table 3. In this manual, detailed instructions are given for the turbulent flow simulation and laminar flow simulations using non-uniform grid and uniform grid 8 respectively.

Table 3 - Simulation matrix
	Study
	Grid
	Model

	V&V of friction factor and axial velocity profile
	2,3,4
	Laminar

	V&V of friction factor
	6,7,8
	

	V&V of friction factor
	0,2,4
	

	V&V of friction factor
	4,6,8
	

	Axial velocity, centerline velocity
	8
	

	Axial velocity, centerline pressure, centerline velocity
	T
	Turbulent





All analytical data (AFD) for Laminar Pipe Flow and EFD data for turbulent pipe flow can be downloaded from the class website (http://css.engineering.uiowa.edu/~me_160). 








Table 4 - Figures and data sets needed to be saved
	Grid
	Flow
	Convergence Limit
	Figure
	Data

	T
	Turbulent
	1.00E-06
	*
	 

	8
	Laminar
	1.00E-06
	Residuals
	**

	8
	Laminar
	1.00E-05
	Residuals
	Wall Shear Stress

	7
	Laminar
	1.00E-06
	 
	Wall Shear Stress

	6
	Laminar
	1.00E-06
	 
	Wall Shear Stress

	4
	Laminar
	1.00E-06
	 
	Wall Shear Stress

	4
	Laminar
	1.00E-05
	 
	Wall Shear Stress

	3
	Laminar
	1.00E-06
	 
	Wall Shear Stress

	2
	Laminar
	1.00E-06
	 
	Wall Shear Stress

	0
	Laminar
	1.00E-06
	 
	Wall Shear Stress

	* Axial velocity profile with EFD data, normalized axial velocity profile at x=100D,
centerline pressure distribution with EFD data, “centerline velocity distribution”, contour
of axial velocity, velocity vectors  showing the developing region and developed regions.

	**Wall Shear Stress, velocity profile (10pts), centerline velocity distribution

















3. Open ANSYS Workbench Template
3.1. Start > all programs > ANSYS 14.5 > workbench 14.5
[image: ]
3.2. Toolbox > Component Systems. Drag and drop geometry, mesh and fluent components to project schematic as per below. 
[image: ]
3.3. Click on left upper corner of the components then select rename. Change the names as per below.
[image: ]
[image: ]
3.4. Create connections between component as per below. You can select components part and drop it onto the target component part to create connections.
[image: ]
3.5. File > Save As. Save the workbench file to H drive. The H drive is shared between the computers in engineering labs.
[image: ]

4. Geometry Creation
4.1. Right click Geometry and select New Geometry. (Since all the geometries are linked together, only one geometry creation is required)
[image: ]
4.2. Select meter for unit and click OK.
[image: ]
4.3. Select the XYPlane under the Tree outline and click New Sketch button.
[image: ]
4.4. Right click XYPlane and select Look at.
[image: ]
4.5. Select Sketching > Rectangle. Create a rectangle geometry as per below.
[image: ]

4.6. Select Dimensions > General. Click on top edge then click anywhere. Repeat the same thing for one of the vertical edges. You should have a similar figure as per below.
[image: ]
4.7. Click on H1under Details View and change it to 7.62 m. Click on V2 and change it to 0.02619 m.
[image: ]

4.8. Concept > Surface From Sketches and select the sketch and hit apply.
[image: ]
4.9. Click Generate. This will create a surface.
[image: ]
4.10. File >Save Project. Save project and close window.
[image: ]
4.11. If you see the lightning sign next to Geometry in the workbench then right click on Geometry and click update as shown below. If you don’t see the check mark after you update then you may have made a mistake when you created the geometry. 
[image: ]

5. Mesh Generation
5.1. Right click Mesh and select Edit. 
[image: ]

5.2. Right click on Mesh then select Insert > Mapped Face Meshing.      

[image: ]

5.3. Select your geometry and click Apply.
[image: ]
[image: ]

5.4. Click on the edge button. This will allow you to select edges of your geometry.
[image: ]
5.5. Right click on Mesh then select Insert > Sizing.
[image: ]
5.6. Hold ctrl button and select the top and bottom edge then click Apply. Specify details of sizing as per below then click Apply again. 

Laminar
[image: ]


Turbulent
[image: ]
5.7. Repeat step 5. Select the left and right edge and click Apply for uniform grid flow and change sizing parameters as per below. Change the sizing parameters separately for non-uniform grid as per below. Make sure to select edges individually when changing sizing parameters for non-uniform grid.
Uniform Grid 8
[image: ]
Non-uniform Grid Left Edge
[image: ] 
Non-uniform Grid Right Edge
[image: ]
5.8. Click on Generate Mesh button and select mesh under outline.
[image: ]
[image: ][image: ]Non-uniform Grid
Uniform Grid 8


5.9. Change the edge names by right clicking and selecting create named selection. Name left, right, bottom and top edges as inlet, outlet, axis and wall respectively. Your outline should look same as the figure below.

[image: ]

[image: ]
[image: ][image: ]Non-uniform Grid
Uniform Grid 8


5.10. File > Save Project. Save the project and close the window. Update mesh on benchmark if necessary.
[image: ]



6. Solve
6.1. Right click Setup and select Edit.
[image: ]

6.2. Under options check Double Precision and click Okay. 
[image: ]

6.3. Solution Setup > General > Check. (Note: If you get and error message you may have made a mistake while creating you mesh)
[image: ]


6.4. Solution Setup > General > Solver. Choose options shown below.
[image: ]
6.5. Solution Setup > Models > Edit. Select 
Laminar flow
[image: ]
Turbulent flow

[image: ]

6.6. Solution Setup > Materials > air > Create/Edit. Change the density and viscosity as per below and click Change/Create. Close the dialog box when finished.
[image: ]
6.7. Cell Zone Conditions > Zone > surface_body. Change type to fluid and click ok. Select material name as air and click ok.
[image: ]
[image: ]
6.8. Solution Setup > Boundary Conditions > inlet > Edit. Change parameters as per below and click OK. (Note: Change inlet velocity to 0.2 m/s for laminar flow)

Laminar flow
[image: ]
Turbulent flow
[image: ]
6.9. Solution Setup > Boundary Conditions > outlet > Edit. Change parameters as per below and click OK. (Note: Outlet pressure is 0 Pa for laminar flow)





Laminar flow
[image: ]
Turbulent flow
[image: ]

6.10. Solution Setup > Boundary Conditions > wall > Edit. Change parameters as per below and click OK.







Turbulent flow
[image: ]

6.11. Solution Setup > Boundary Conditions > Operating Condition. Change parameters as per below and click OK.
[image: ]

6.12. Solution Setup > Reference Values. Change parameters as per below. 
Laminar flow
[image: ]












Turbulent flow
[image: ]

6.13. Solution > Solution Methods. Change parameters as per below.
[image: ]
Turbulent flow
[image: ]
Laminar flow
6.14. Solution > Monitors > Residuals > Edit. Change convergence criterion to 1e-6 for all five equations as per below and click OK. (Note: for iterative error study you will need to use 1e-5)
[image: ]
[image: ]

6.15. Solution > Solution Initialization. Change parameters as per below and click Initialize. (Note: use 0 Pa and 0.2 m/s for laminar flow for pressure and velocity respectively)
[image: ][image: ]

6.16. Solution > Run calculation. Change number of iterations to 1000 and click calculate.





7. Post Processing
Displaying mesh
	Display> Mesh
[image: ]
Select all the surface you want to display, lines and points you create can be displayed here as well.
Plotting and Printing Residuals
Display > Residuals. Click on plot button then click on ok.
[image: ]
[image: ]
[image: ]
File > Save Picture. Using option as per below save the residuals.

[image: ]
[image: ]

Creating Points and Lines
Surface > Point. . Change x and y values as per below click Create. Repeat this for more lines shown in the table
[image: ]
	Point Name
	x0
	y0

	point-1
	7
	0

	point-2
	7
	0.005

	point-3
	7
	0.010

	point-4
	7
	0.015

	point-5
	7
	0.020

	point-6
	7
	0.021

	point-7
	7
	0.022

	point-8
	7
	0.023

	point-9
	7
	0.024

	point-10
	7
	0.025



Surface > Line/Rake. Change x and y values as per below click Create. Repeat this for more lines shown in the table
[image: ]
	Surface Name
	X0
	Y0
	X1
	Y1

	x=10d
	0.5238
	0
	0.5238
	0.02619

	x=20d
	1.0476
	0
	1.0476
	0.02619

	x=40d
	2.0952
	0
	2.0952
	0.02619

	x=60d
	3.1428
	0
	3.1428
	0.02619

	x=100d
	5.238
	0
	5.238
	0.02619



Plotting Results
Results > Plots > XY Plot > Setup. Select inlet, outlet, and the lines you created and change setting as per below then click Plot. 
[image: ]
XY Plot > Setup > Curves. Curve # 0 selects Pattern and click Apply. Repeat this for all the curves.
[image: ]
Download the data for the Simulation from the class website (http://www.engineering.uiowa.edu/~me_160/).
XY Plot > Setup > Load File. Select axialvelocityEFD-turbulent-pipe.xy and click OK. 
[image: ]
Results > Plots > XY Plot > Setup. Change Y function to Pressure and select axis then click Plot.
[image: ]
Repeat #6 for loading experimental data for the centerline pressure 
[image: ]
Select axis and change plot direction as per below. Then plot the figure.
[image: ]
[image: ]
Exporting Data
Select >Plots >XY Plot. Then change parameter as per below and click Write. This will export the shear stress along the wall of the pipe. You will need this data to compute the shear stress coefficient at the developed region.
[image: ]

Plotting Vectors and Contours
Results > Graphics and Animations > Vectors > Set up. Change the vector parameters as per below and click Display.
[image: ]
[image: ]
Results > Graphics and Animations > Contours > Set up. Change the vector parameters as per below and click Display.
[bookmark: _GoBack][image: ]
[image: ]
Close window and save workbench file.

V&V Instructions
V&V Instructions for Velocity Profile
Right click Solution > Select Edit…
[image: ]
Create reference points
Results>Plots>xy plot>Set Up …
[image: ]
Change parameters as per below and click Write… . Make sure to select points 1 through 10.
[image: ]
Name file according to which grid solution you are using.
[image: ]
Open file using Wordpad, copy points to input into V&V Excel file.
[image: ]
Paste value into V&V Excel file according to its y position and its grid number. Use the Keep Text Only paste function by right clicking in the cell and selecting it from the paste options.
[image: ]
Repeat this process for the remaining y location points and then the two remaining grid solutions. All yellow cells should be filled.
V&V Instructions for Friction
Right click Solution > Select Edit…
[image: ]

Results>Plots>xy plot>Set Up …
[image: ]

Change parameters as per below and click Write…
[image: ]
Name the file according to grid number and save to project folder.
[image: ]
Open file with Notepad and copy wall shear stress at the x location of 7.62m.
[image: ]
Paste the value into corresponding cell in the V&V template.

[image: ]
Make sure when pasting you select Keep Text Only and you select the proper cell corresponding to the grid number.
[image: ]
Repeat this process for the remaining six grids. Each yellow cell should be filled.


8. Exercises

You need complete the following assignments and present results in your lab reports following the lab report instructions

                                      * 1-4 and 6 are for laminar flows, 5 is for turbulent flows
              
8.1. Iterative error studies: Use grid #4 and #8 with laminar flow conditions. Use two different convergent limits 10-5 and 10-6 and fill in the following table for the values on friction factors. Find the relative error between AFD friction factor (0.097747231) and friction factor computed by CFD, which is computed by:
[bookmark: OLE_LINK1]


To get the value of, you need export wall shear stress data. Then use the wall shear stress at the developed region to calculate the friction factor. The equation for the friction factor is C=8*τ/(r*U^2). Where C is the friction factor, t is wall shear stress, r is density and U is the inlet velocity. Discuss the effect of convergent limit on results for these two meshes 

	Mesh No.
	f (10-5)
	F(10-6)

	4
	                   (       %)
	                 (     %)

	8
	                   (       %)
	                 (     %)


NOTE: (1). X and R should be NX+1 and NR+1. So, when you can create mesh manually, you need use NX, NR (112×10) for mesh 4 and (452×44) for mesh 8.            
· Figure need to be saved: residuals history for mesh 8 for two convergent limits.
· Data need to be saved: the above table with values.
· ANSYS case need to be saved: mesh 8 with convergent limit 10-6

8.2. Verification study for friction factor of laminar pipe flow: Run the simulations with the meshes shown in the table. Using mesh 4 as the “fine” mesh, and run verification with grid refinement ratio 1.414 and convergence limit 10-6. Compute the parameters in the table (Refer to class website for V&V instructions). Using Mesh 8 as the “fine” mesh and repeat the above procedure using the same grid refinement ratio 1.414.
	    Meshes
	Pg
	Cg
	Ug(%)
	Ugc (%)

	2,3,4
	
	
	
	

	6,7,8
	
	
	
	


       
       Which set of meshes is closer to the asymptotic range (i.e. Cg close to 1.0)? Which set has a lower grid uncertainty (Ug)? Which set is closer to the theoretical value of order of accuracy (2nd order). For the fine mesh 8, also compare its relative error of the friction factor (the one using convergent limit 10-6 in the table in exercise 1) with the grid uncertainty for 6,7,8, which is higher and what does that mean?

· Figure need to be saved: Figures and tables from V&V spread sheet.
· Data need to be saved: the above table with values

8.3. Effect of grid refinement ratio on verification results (friction factor): Still use mesh 4 and 8 as the “fine mesh”, but run verification with grid refinement ratio 2 for laminar pipe flow and convergence limit 10-6. 
	Meshes
	Pg
	Cg
	Ug(%)
	Ugc (%)

	0,2,4
	
	
	
	

	4,6,8
	
	
	
	



Compared to results in 2, which set of meshes is sensitive to grid refinement ratio? Why?
· Figures need to be saved: Figures and tables from V&V spread sheet.
· Data need to be saved: the above table with values

8.4. Verification study of axial velocity profile: Use mesh 4 as the “fine mesh”, use grid refinement ratio 1.414 and convergence limit 10-6. Follow the V&V for velocity how to in the post processing section. Save the figures and discuss if the simulation has been verified. 
· Figures need to be saved: Figures showing Ug, Ugc with |E|. Discuss which mesh solution is closest to the AFD data, why?
· Data need to be saved: None.

8.5. Simulation of turbulent pipe flow
Run simulation with convergence limit 10-6 and compare with EFD data on axial velocity profile and pressure distribution along the pipe. Export the axial velocity profile data at x=100D, use EXCEL to open the file you exported and normalize the profile using the centerline velocity magnitude at x=100D. Plot the normalized velocity profile in EXCEL and paste the figure into WORD.
· Figures need to be saved: Axial velocity profile with EFD data, normalized axial velocity profile at x=100D, centerline pressure distribution with EFD data, “centerline velocity distribution”, contour of axial velocity, velocity vectors  showing the developing region and developed regions.
· Data need to be saved: Developing length and compared it with that using formula 6.6 in textbook.

8.6. Comparison between laminar and turbulent pipe flow
Compare the results of laminar pipe flow using mesh 8 in exercise 1 (convergent limit 10-6) with results of turbulent pipe flow in exercise 5.  Analyze the difference in normalized axial velocity profile and developing length for laminar and turbulent pipe flows.
      NOTE: (1). Since you have finished laminar simulation using mesh 8 in exercise 1, you can just open the case file you saved and output the figures and data you need.
· Figures need to be saved: Axial velocity profile with AFD data, normalized axialvelocity profile at x=100D, “centerline velocity distribution” for laminar flows.
· Data need to be saved: Developing length for laminar pipe flow and compared it with that using formula 6.5 in textbook. 

8.7. Questions need to be answered in CFD Lab report
8.7.1. Answer all the questions in exercises 1 to 6
8.7.2. Analyze the difference between CFD/AFD and CFD/EFD and possible error   sources.
8.7.3. Analyze the difference between ANSYS predictions and your own calculations (using formula in CFD lecture) for order of accuracy and grid uncertainties.

image1.png
Fle Vew Toos Units Extensins Hep HOME INSERT DESIGN PAGELAYOUT REFERENCES MAILINGS REVIEW VW MathType ACROBAT TimurKe.. *

New E50pen... [l save (B save as.. | Glimport... | < 2 Refresh Project 7 Update Project | & @ 3 Previous GS[NoMarkup - D - T o
R & INet B Show Markup -
a Spelling & ¢ Language  New Delete Track Accept Compare Protect
Analysis Systems = Grammar ~ " Comment - Show Comments | Changes - [2]Reviewing Pane =~ " 3 - -
% ooyt - a Froofing Comments Tracking 5 Changes  Compare ~
Autodyn
3 1 &
@ engineerng0ats 2 @ Geomery P
% Etemsl Connection
Etemsl Data
@ FinteElementitodeler -
B ren = &) =[0 > Thetntemet » tpinmaiovacds |
[ Fluent (vith Tarid meshing)
@ Geometry Organize v
& 1CEM CcFD x
N echanics 5oL Favorites
@ Mesh 5% Downlosds
[ MiosoftOfficetiel U & Recent Places 3. Open ANSYS Workbench Template
2 pobfou
oo lawtaldng 5 Recently Changed 3.1. Download CFD Lab 1 Template from class website.
Polyflow-Exrusion & public 3.2. Open Workbench Project Zip file simply by double clicking file. This file contains all
pi 5 Libraries the systems that must be solved for CFD Lab1.
g - — = ——
e D Documents -
3 st Fud Flg Music -
g2 oo ictures
€] Windows Update Videos
B winkar U

<A XPS Viewer

b Abqus612:1

Ul Accessories uments

Ui ActvePerl 516.3 Bild 1603 (64-bit

b ANSYS145 Pictures

5 ANSYS Icepak 145

I\ Mechanical APDL 145
Mechanical APDL Product Launcher

N Uninstii 145
Workbench 145

)i ANSYS Client Licensing

Ui Aqus

iy

b Fluid Dynarmics

Ui Help

U} Meshing lelp and Support

Ui Remote Solve Mansger

U vsiies

4 Back

% Computer

G Network

Music

ontrol Panel

Devices and Printers
Intermediate Lab #1 Manual VS.docx

[5 e s

Defautt Programs

oh programs and

PAGE3OF36 2511 WORDS [




image90.wmf
100%

CFDAFD

AFD

FactorFactor

Factor

-

´


oleObject1.bin

image91.wmf
CFD

Factor


oleObject2.bin

image2.png
Analysis Systers,

B Component systens

@ Autodm

@ o

@ Engineering Data

+ Etemal Comection
Exemal Data

@ FiiteElementiodeler

B Flent

Fluent (vith TGrid meshing)

Gromety.

e crD

Mechanical Mode
@ Mesh

[ Microsoft Offcecel
o Polyflow





image3.png
Fle Vew Toos Units Extensons Help REFERENCES MALINGS REVIEW VIEW MathType ACROBAT TimurKe.. ~

“New E50pen... [l save (B save As... | Glimport.. | <pRecomect @ RefreshProject 7 Update Project | (3 Project. ) CompactMode #
AaBbC( AaBbCeDc AaBbCcDC

Headingl  TNormsl TNoSpsc.. [<| Etng

Paragraph
T

A,

e —

Update e

5 Stytes 5 -

Duplate

@ Finite ElementModeler Clear Generated Data

D Fluent Delete

I Fluent(vith Tard meshing)

@ Geomety

& am e

I\ Vechanical DL

@ MechanicalMode

@ Mesh

[ Microsoft Offcecel

5 Polyflow
Polyflow - Blow Molding
Polyflow -Extrusion

Propertis

System Coupling

B Custom Systems

lid Flow (P -> Static Structural
FS: Flid Flow (FLUENT) > Static Structural
Pre-Siress Modd
RandomVibraton
Response Spectnum
Thermal-Stress

5 Design Exploraion

@ DirectOptimizaton

(] Response Surface
@ Response Suface Optimization
dh] SxSigma nalysis

T View Al Custonize.

double clickin file This file contains all

@ Draga Toolboxitem antop ofa systemto reuse componentsand exchange data.





image4.png
- B - s - < -
B B B B
2| @ coomty 2|@ Georairy ? . 2@ e 7. 2 .
pipe. 3 @ mMesh P 3 @ soubn 7 3 .
‘uniform grid & laminar (1°6)

o . ° G

B B

2 @ Gomty ? 2 @t P

2@ 7. 3| @ st 7,

turbulent (1-6)




image5.png
Wn[=]e

turbulent (1-6)





image6.png
REFERENCES MALINGS REVIEW VIEW MathType ACROBAT TimurKe.. ~

AaBbC: AsBbeeoe Aasbceoe | |

Headingl  TNormsl TNoSpsc.. [<| Etng

|Eld

- 0 - 0 Stytes 5 -

- .
‘Open from Repository... 2|@ Geometry ? . 2@ ek P,
e ——_— - s

GORE

Get Changes from Reposiory.
Manage Repository Project
Launch EXM Vieb Clent...

mport...
Archive...
Restore Archive.

A0E(©

Saipting turbulent 16-6)

[L]

ExportReport...

1H:\CFDICFD Lab 1\CFD Lab 1 Student.wbp)
2H:\CFD\CRD Lab 11CFD Lab 1 Student V2.wbpj
‘3H:\CFD\CRD Lab 11CFD Lab 1 Solutons V3.wbp)
4H:\CFD\CRD Lab 3\CFD Lab 3 V2.nbp)

crisQ

B DesignBolorsion
@ DirectOptimizaton

(] Response Surface
@ Response Suface Optimization b ()
[al] SxSigma Analysis

d select New Geometry. (Since all the geometies are linked
creation is required)

View Al Custonize.





image7.png
CFD Lab 1 Solution V4 - Workbend]

File View Tools Units Extensions Help
OINew EFopen... (ol save B save ... | Gimport.

v R x

“oRecomnect @ Refresh Project 7 Update Project | (3)project () Compact Mode

: :
® ceoreiny 2 o
@ NewGeometry..
Inport Geometry
2:3:3”"“5, & ot
[ Fluent (vith TGrd meshing) TrensferData From e >
St Transfr Dta ToNew
& e - s
I vechanica poL { “"": N
@ MechanicalModel ] Refes
@ Mesh Reset
[ Miaosoftofficebrce B Rename
3 Polyflow properties
Polyflow - Blow Molding
Polyfow-Bxrusion Qudktel
Addnote

System Coupling
B Custom Systems

id Flow (CFX) > Stati Structural
FSL: Fuid Flow (FLUENT) -> Static Structura!
Pre-Stress Modal
Random Vibraton
Response Spectum
Thermal-Stress
@ DesignExploraion
@ DirectOptimizaton
Parameters Correlation
(] Response Surface
@ Response Surface Optimizzion
[dl] SxSigmaanalysis

T View Al Custonize.

& soiton 7
turbulent (1e-6).

Manual V5 - Wor

AaBbC( AaBbCeDc AaBbCcDC
Heading1 T Normal

7N Spac

g

1
N Paragraph 5
oo v

e p—)
20O 1670 L 58t 2ty
[ S
DL DS ey

o En

Stytes

d select New Geometry. (Since all the geometies are linked

try creation is required)

@ Double-lck componentto et

RFERENCES  MALINGS  REVEW VW MatiTpe  ACROBAT Timurke. - [0

i

Editing





image8.png
Project - Workb

Fle Vew Toos Units Hep

[Jnew E50pen... [l save [l savess... | limport... | SpReconnect 2 Refresh Project 7 Update Project | @Project () Compact Mode
_ R X
8 Anlysis Systens
— [ File Create Concept Tools View Help
) gedric adE (@] D0 i s b RERR - ||S+QQAQEAQAE |+ (6 (/o
:,,:u;uy.g; I A A PAATATNAD
@ Flud o (FLUR) | xvptane + 3 | None - ¥ || FGenente @ Share Topolooy [EParameters
(@ HarmonicResponse | Bbxude goRevole QoSweep Skin/Loft || BMTH/Sufore @ Blnd = & Chamier 4 Point
4 1cEngine 3@ sew | |5 Gine 2 [Graphics L
LinearBucking 5 @ souton |
Mognetosatc 5@ Renits
@ vodal ANSYS Workbench
Flid Flow]
) Randomvibraton s
) Response spectum Select dested ength
& Rgidoynamics
@ Satic sructral @ weter © Foat
O s e € Contimeter € ben
Thermal-Electic
@ Transient Stuctural © wimeter
B Transient Thermal ®
ComponentSystens peremete
CustomSystems - -
Design Exploration r use. =
T~ Enabl large model support
»
Y
0.000 15.000 30.000 (m) 74 X
[~ SS—— S
7.500 22500
Mogel View [Print Preview
O Fesdy No Selection o
T View All / Customize.

® starting DesignModeles





image9.png
A:Fluid Flow (FLUENT) -

File Create Concept Tools View Help.

AHBE[ @] Duns G [[sec[ b MBMB| 0|5 ¢ QRQEQ A E |46l |

LA AP AN

SER s

\: Fluid Flow (FLUENT)
N i

ok ZPlane

o VZPlane

€0 0 Parts 0 Bodies

Sketching_Modeling

Details View L)
= Details of xYPiane

Plane. XYPlane.

Sketches o

Export Coordinate System? | No

10.000

- #9]|| FGenerste W chare Topolooy | WBdrude gloRevolve @ Sweep @ SkinvLoft WATH/Suface Bl ~ & Charnier @ Point [E]Parameters

20,000 ()

)

Model View [ Print Preview

Q Ready

iPlane

Vee b b

=& &)

J

N
# Find -
CcD. AaBbCCDC AaBbCCD: | #.Replace
seE.  Stron uote |- Change |
o et GOt soea
| eatng |
T 7 &





image10.png
A: pipe - DesignModel

File Create

Concept Tools View Help

Bo ]| Due Greie [[se [ b | B R@W@| o |8 8

‘.@

RAEQXE|[+[@le |2

®

.(.'HL

We e f fo A fo A

X¥Plane

v | sketen v ¥ || JGenente @ hare Topolony [EParameters

i
|
|
|
|
|

Bbtude

GoRevove Qo Sweep g Skin/Loft || WNTHin/Surfoce @ Blend ~ & Chiamfer MSice || @Point E) Conversion
Graphics 2

1)
= Show Dependencie
b Rename

Sketching_Modeling
Details View L)
= Details of xYPiane
Plane X¥Pla,
Sketches 1

Export Coordinate System?

L

0.000

10,000 (rr)

5.000

Model View [Print Preview

9 Ready

iPlane

630 |

Meter 0 0 /]
P [E

@EHS O -

X
[ uks

Paste

lipboard &

Intermediate Lab #1 Manual V5 - Word

HOME INSERT DESIGN PAGELAYOUT REFERENCES MAILINGS REVEW VIEW MathType ACROBAT TimurKe.

T K A Aae A
TmesNewRo-[12 -| A & Aa- 4 AaBbC: | AsBbcee| Aasbeeoe | |
Font 5 rmgn w syies .

4.3. Select the X YPlane under the Tree outline and click New Sketch button.

wa[n b DEO@ - [SERQQEAAEHS. 2

FIEE

Rownie e Qe $simicn 0

4.4, Right click XYPlane and sclect Look at.
4.5. Select Sketching > Rectangle and create a rectangle geometry as per below.

@t Do

Noncommercial use only.

A





image11.png
A:Fluid Flow (FLUENT) -

File Create Concept Tools View Help.

QB @] D Greio [[seect M T [mE BB C-]|S ¢ QRQQE QK [l |2

|

|

| W~ £~ fiv S~ A~ A
| v 3| None

X¥Plane ~ ¥ || FGenerte W hae Topolooy | WEdrude gloRevolve @ Sweep @ Skinvloft WATH/Suface % Blend - & Charnier @ Point [E]Parameters

Sketching Toolbores [
S E—— )
“\ Line
& TangentLine
& Line by 2 Tangents
A\ Polyiine
(SPalygon
[CiRectangle — Adois
O Rectangle by 3 Points
Howl
@ Circle
£dCirce by 3 Tangents
~Arc by Tangent
e Arcby 3 Points
o Arc by Center
Delipse
2 Spline.
Modity B
Dimensions
Constraints
Settings
Sketching [ Modeiing |
Detsis View [

-

0.000 10600 20,000 ()
5000 15.000
Model View [Print Preview
'© Rectangle - Click, or Release, for opposte comer of rectangle No Selection Mew  fi67 b1

1. Mesh Generation

=@ % |
s
# Find -
CcD. AaBbCCDC AaBbCCD: | 2 Repioce
seE.  Stron uote |- Change |
o et GOt soea
| eating |
G 7 B





image12.png
oy s S /EQaEEes n
s
e < mem < B Foar W i G Gt [y ==





image13.png




image14.png
Concept Tools View Help

~ tinesFrom Pant ect [y % [[ 0 () W [ &3 | 8

5 Lines From Sketches [o |92

) Lines From Edges =
A 3D Curve

~ Split Edges |+ Generate @9 Share Topology  [FE]Parameters

® Sufaces From Edges

Skeching Tool 9|

oft || WThin/Surface @ Blend ~ & Charnfer @pSice || dPoint E) Conversion

&7 Surfaces From Faces
Cross Section »

Dimensions -
[ General

et Horizontal

[ Vertical

4 LengthDistance

< Radius

) Diameter

A Angle

7§ Semi-Automatic

& edit i "

I Move
[H Animate

88 Display

Constraints -
Settings

Sketching [ Modeling

Details View L)
=) Details o Sketcnt

Sketch Sketcht
Sketch Visibilty | Show Sketch
Show Constraints? | No

=) Dimensions: 2

Hi 762m
00219 m
= | Edges: 4
Line n7
Line s
tne = ‘ Dm—:l
Line into

Model View [Print Preview

@ Generl  Seect point o 20 Edg for dimension or use RV for options

= L&

Meter 0 0 /]

M H S s

| HOME | INSERT  DESIGN

%

B [TimesNewRo - |12 ~| A AaBbC AaBbCcDc AaBbCcDc
Pate o B I U-axx, X Headingl 1 Normal TN Spac
lipboard 1 Font stes

4.7. Click on Hlunder Details View and change it to 7.62 m. Click on V2 and change it to
0.02619 m.

=) Details of Sketcht

Sketch Sketcht
Sketch Visibility | Show Sketch
Show Constraints? | No

=) Dimensions: 2

HL 762m
002619 m
=) Edges: 4
Line nis
Line Ln16
Line 17
Line |tnis

4.8. Concept > Surface From Sketches and sclect the sketeh and hit apply.
4.9. Click Generate. This will create a surface.

o BT T LISHIEE TORY TP I
"o pe 4o

e e
P ‘|
PAGES OF 38 oRD B B

PAGELAYOUT REFERENCES MAILINGS REVIEW VIEW MathType ACROBAT TimurKe,

i

Editing





image15.png
A: pipe - DesignModeler

| Fie Create Concept Tools View Help
| AEE (@] D Gres [Jsees[ b |0 BB | O | =
(S eQAAEQCEF 6l @

W W L i e A S A
I
I

XiPlane v | Sketent v ¥ || Geneute @ Share Topology [FPare
Recrude goRevoive Qo Sweep g Skinloft || @Thin/Surface @ Blend v & Char
Tree Outline 2 [Graphics
B8 A pipe ]
-3 X¥Plane
9 Sketch
3 ZXPlane
e VZPlane
e Surfacesid
o Sketch
-, 1Part, 1 Body
B Surface Body





image16.png
Analysis Systers,

B Component systens

@ Autodm

@ o

@ Engineering Data

+ Etemal Comection
Exemal Data

@ FiiteElementiodeler

B Flent

Fluent (vith TGrid meshing)

Geomety.

e co

Mechanical Mode!

@ Mesh

[ MicrosoftOffcecel
o3 Polyflow

- 3 -
1

2@ msh @ a2
on-uniorm grid 3

7
7

turbulent (1-6)

3
L .
& soison




image17.png
Manual V5 - Wor

Fle Vew Toos Units Extensons Help AGELAYOUT REFERENCES MAILINGS REVEW VW MathType ACROBAT TimurKe.. v

e Gopen... [ swve [ smve ss.. | limport... | <oRecomect @ Refeshproect 7 Updateproject | (3 ot Q) Compctivade P
2 AaBDBC( AaBbCcDe AzBbCcDC |
5 Paragraph o Styies 5 ~

ning $1gn NEXT 10 GEOMETry 11 e WOTKDENCA te FgnT CLicK
update as shown below. If you don’t sce the check mark after you
Edit Geometry.. ave made a mistake when you created the geometry.

Replace Geometry

@ FiiteElementiodeler Duplcate
B rent T D
=2 ::::ymmndmhm) Transfer Data To New »
# 1M 7 Update
I\ Vechanical DL
@ MechanicalMode

& soiton 7

s ——
A @ feere oo
3 Polyflow Properties.
Polyflow-BlowMolding Quick Help
Polyflow-Extrusion
pon

@ Resits -
T View Al / Customize...
@ Double-clck componentto et

Y CPD Lab 1 Soluions 3 TAPMIZ2APM ANSYS VLSS whpz..  63H9KE
Y CPD Lab 1 Soltions IASAIIPM ANSYS VLSS whpz..  8429KE
N PO Lab stucent TASIZIIPM ANSYS 1SS g 1838

B CPDLab 1 Student TA/ZILOLPM ANSYSVL4S aibpz 04k8
5 cleanup-fluent-L-COE203-5824 JAY/IZS2PM Windows Batch il 1k
5 cleanup-fluent-1-COE203-6928 JAY/213H5AM  Windows Batch File 18
@ Geom INYNIIGBAM  ANSYS\ISS agdb..  2327KB
@ g0 JAYRIIGA2AM  ANSYS LSS mes, B8 o

[ grido.msh 77192013
[ grid2msh 7/19/2013 31

MSH File 6K

MSH File 20K8. 19 1@ WGeometn..

4 @ ReslseGeonery B

S @ sk o

§@Re  ToweOwmroane
Pl TowOsaTones >

7 e

Reset

0 fewe
Fropries
Qe

PAGE 10 OF




image18.png
CFD Lab 1 Solution V4 -V

File View Tools Units Extensions Help
INew EFopen... (o save B save ... | Glimport... | < Recomect @ RefeshProect

7 Update Project | (3 Project. @) CompactMode.

@ Finite ElementModeler

B Flent

3 Fluent (vith TGrid meshing)
Geomety.

& am e

I\ Vechanical DL

@ MechanicalMode

@ Mesh

[ Microsoft Offcecel

2 Polyfiow

Polyflow - Blow Molding

Polyflow -Extrusion

@ Results

TransferDataToNen >

7 Update

7
Reset :
i B
eropertes t(1e6)
QuickHelp
AddNote

T

View Al Customize...

ation

e . e
Cm—

@ Right dicktoupdate componer:

B CFD Lob1 Solutions V3 JAYMIZAPM ANSYSVI4S ibpz
B CFDLab1 Soltions IS/IIGIOPM ANSYSVL4S ibpz
N CFOLob 1 student TAYNIZSIPM ANSYSL4S bpi
B CPDLab 1 Student TA/ZILOLPM ANSYSVL4S aibpz
cleanup-fluent-1-COE203-5824 JAY/IZS2PM Windows Batch il
cleanup-fluent-1-COE203-6928 JAY/213H5AM  Windows Batch File
@ Geom JAYRIGZAM  ANSYSLAS agab.
@ g0 JAYRIIGA2AM  ANSYS LSS mes,
[ griddmsh 79213 M Fie

[ gridzamsh 7197233 M File

5.2. Right click on Mesh then select Insert > Mapped Face Meshing.

AGELAYOUT REFERENCES MAILINGS REVEW VW MathType ACROBAT TimurKe.. v

e<h and select Edit. (Nots: Since some grid systems require two different
terions, some meshes are linked together and only require one mesh

Manual V5 - Wor

AaBbC, |assbcede assbcene |
Paragraph L] Styles. ] ~





image19.png
A Fluid Flow (FLU

| File Edit View Units Tools Help ||| 3 GenersteMesh 8 [0 [A] (@1~ @worsheet || % % %~ 0 @@ @ | &+
| Show Vertices | @@ Wirehrame | [Edge Coloring ~ £+ Ji= £~ A~ A= ||| hicken Annotations
|Mesh < Updste | @aMesh ~ @k Mesh Control v | et Graph | 8 Options

Mesh
HLY2013 1116 AM

Noncommercial use only

YA QEQQE TS| O

@ Method

8, Siing

Prra—
A Refinement
Preview ,
Show |

@ Mstch Control
@ pinch
A nfation

 CreatePinch Controls

2 Clear Genersted Data
b Rename

~

Details of "Mesh” L)
= Defautts
Physics Preference [CFD

Salverpreference | Fluent > X
Relevance o w0m 0 0200 ()
e

Sizing

Infiation
CutCellMeshing
Active No
Advanced
Defeaturing

Statistics

0050 0.150

Geometry {Print Preview) Report Previcn,

Messages

[Metric (m, kg, N, 5,V, A)_Degrees rad/s Celsius




image20.png
Details of "Mapped Face Meshing’ - Mapped Face Meshing

Constrain Boundary No





image21.png
A Fluid Flow (FLI
| File Edit View Units Tools Help ||| o GeneroteMesh 1 i [A) @~ Y orkoneer ||
| 5 Show Vettices | @@ Wireframe | [1Edge Coloring » £~ A~ Av A~ A~ Pl
|Mesh % Update | @3Mesh v @k Mesh Control v | 1t Graph | G Options

»

Mapped Face Meshing
Model (A3) L2013 1118 AM

Iy Surface Body [ Mapped Face Meshing Noncommercial use only
Y
2 Coordinate Systems
-4/ Mesh

/B Mapped Face Mesting

R RRERR &

| Thicken Annotations

QA |QERAAE /2 & O

v
Detsis o "Mipped Face Mishing’ - Mpped Face Meshing %
= scope ®

Scopig Methad [ Geamety Seidtion

Geametsy Trace —— X
5| Definition 0.000 0.100 0.200{m)

Suppresses _[No _—— e

vetnaa Quasisteri o i

Constrai Baunaany o
= Advanced Geometry {Print Preview Repor Preview;

Speaia sdes [N Seecion

Specified Corners | No Selection Meso0

Speatieatnd: Mo seecton

[Metric (m, kg, N, 5,V, A)_Degrees rad/s Celsius




image22.png
CFD Lab 1 Solution V4 - Workbench -

M :
L Times New Ro - AaBDC/ AaBbCcDc AsBbCcDC

E3
Normal 1 No Spac.

analysis 5y5{((g) B : uniform grid & - Meshing [ANSYS Academic Teaching Advanced]
& Componentd—

| File Edit View Units Tools Help || =i | o GenersteMesh 1B 0 [X) [@ v (JWorksheet ix 5
PR H-RERER @ SPARAAQE@RAAE G E DO

|| 5 Show Vertices §@Wirefrdggoc] [Edge Coloring ~ £~ A~ A~ A~ A~ A | |-IThicken Annotations " show esh & i Random Colors (@ Annotation Preferences
e 5 Upaste | @M ~ B Comvol = | ot

@ FiniteElemd | Outline 2
B et |[[Fiter name +
B Fusnt it | @ project

@ Geomeiy | | & @ Model (82) [0 Mapped Face Meshing
& e 58 Geametry
N vechanical; B Surface Body L |
& e 4 Corate Sy

@ Mesh B-4%p Mesh

[ MicrosoftQ Il e

Folyfiow

Mapped Face Meshing
222013 224 PM

Polyflow-8
Results

0600 ()
Details of "Mapped Face Meshing” - Mapped Face Meshing

Scope
Scoping Method | Geometry Selection Geometry {Print Preview) Report Previcn,
Geometry 1 Face
Definition
Suppressed No

Method Quadrilaterals
Constrain Boundary | No

Advanced
Specified Sides | No Selection
Specified Comers | No Selection
Specified Ends | No Selection

Messages

B No Messages

Start Recoring

5.6. Select the top edge and click Apply. Specify details of sizing as per below then click
Apply again. (Note: For laminar flows grid size refer to Table #2)

PAGE120F38 2544 WORDS





image23.png
B.: Grid 0 - Meshing [ANSYS Academic Teachi

Fie Edt View Units Tools Help || i |  GenerateMesh 18 (i

@+ [ Worksheet ix

TR H-RDEEER &S PAR

QR

Nneae % 0O

| 5 ShowVertices §R Wireframe | [[1Edge Coloring » £+ A

A~ A+ A~ A Pl A Thicken Amotations 2, o /e sk B Random Colors @ Annotation Preferences

|Mesh 3 Update | @ Mesh ~ B, Mesh Control = | et Groph

Hodel (82)
/8 eomety
B Surface Body
/2 CoordnateSysens
° ® Method
Y
% Updae @
3 Generate Mesh ¥, Contact iing
NS & Refinement
[ >
S * | B8 Mapped Face Meshing
 CreatePinch Controls @ Match Control
7SI TEEE g pincn
] Clear Generated Data A Inflation
b Rename
St ooy

Details of "Mesh” L)
= Defautts
Physics Preference | Mechanical

Relevance o

0000

0250

0500

0750

1000 ()

Sizing Geometry {Print Preview ) Report Previe,

Infiation

Messages

Patch Conforming Options
Triangle Surface Mesher |Program Controlled
Advanced

Defeaturing

Statistics

Press FL for Help

[Metric (m, kg, N, s,V, A) Degrees rad/s Cel





image24.png




image25.png




image26.png




image27.png




image28.png




image29.png
(%) B : uniform grid 8 - Meshing [ANSYS Academic Teaching Advanced]

File Edit View Unt: Tools Help || =+ |  GenersteMesh 1 8

@+ [ Worksheet ix

QaEnea 0

7 Show Vertces g2 Wirefame | [Edge Coloring = £+ A= A~ A~ A= A bl I ricken Annotations T show Mesh

J
[THFR-L-RERE &S5 ¢aal
]
]

x

I Randon

Mesh 3 Update | @Mesh + B, Mesh Control ~ | jitic Graph
Outiine

[Fiter. name

AE

Model (82)
58 Geomety
B9 Surface Body
£ Coordnate Systens
X Gobal Coordnate System
& Vet
/B Mapped Face Mesting
/1B Edge szng
/B Edge szng 2





image30.png
0000 0020 0.040 ()
S e

0010 0030




image31.png
Fie Edit View Units Tools Help || i |  GenerateMesh 18 [if

@~ O worshest iy

TR H-RDEEE &S PARAQ

Qa¥xng s o0

7 Show Vertces g Wirefame | [Edge Coloring = £+ i~ A~ A~ A= A Pl FITricken Annototions TgshowMesh k.

B Random Colors > Annotaion Preferences

|
]
]
|

Outline

)

Model | i Virtual Topology | (@] Symmetry | @ Connections | @3 Fracture | @ Mesh Numbering | #8Named Selection

[Fiter. name

Model (B2)
58 Geametry
x By Surface Body
5,3k Coordnate Systems
/3 Gobal Coordinste System

Details of "Model (E2)"
&l

o1

06

Insert
GoTo

@ Isometric View
3 se

3 Restore Defaut

Cursor Mode
View
#9 Look At

=

& SelectAl

@ Hide Body

Suppress Body

Zoom ToFit

X Creste Coordinate System

Update Geometry from Source

0.000 0.030

0015

0,080 ()
0.045

Specir |1 Geometry (FrimtPreview
Color s
et Assocation Timestamp
Viaring| Some edqe o face sze control have smller vlus than th defaul defeaturing tolear Prect>Model> Geometry>Surface Body Bodies> Surfact Monday,Juy 2, 2013 &
Press P for Felp (81 Message [ Edge Selecied Length = 762 m [Vetic m, kg N,5,V, A)_Degress rad/s_Cel





image32.png
A Fluid Flow

Fie Edt View Units Tools Help |||  GenersteMesh 18

By [RE CRAERE @S AR &

QaxmeE| 0

|
]

£ Show Vertices | gRWireframe | [[IEdge Coloring v £~ /i~ A~ A~ A~ M

| Thicken Annotations

| Geomety. @ Vol Body et |

Model (A3)
=,/ Geometry
B9 Surface Body
5k Coordnate Systems
X Gobal Coordnate System
& Vet
/B Mapped Face Mesting
/1B Edge szng
/B Edge Szng 2
/B Edge Szng 3
/B Edge siang 4

Graphics Properties

Details of "Surface Body" L)

T ANSY S

Noncommercial use only

Enter a name for the selection group:

e

@ Apply selected geometry

Material

© Apply geometry items of same:

Fluid/soli Solia

Size

Bounding Box

Properties

Type

Statistics

Section Planes 2 x

~

Association

Timestamp

EEX

The default defeaturing) Project>Model

3/11/2013 12:0544 PM

Press FL for Help

1 Edge Selected: Length = 2619e-002 m

4) Degrees rad/s Celsius




image33.png
Model (B2)
58 Geametry
18 Surface Body
5k Coordnate Systems
/s Global Coordinate System





image34.png
Hodel (E2)
£, 8 Geometry
B Surface 50d
& ,;,nc‘r.msml
e dnste System
/B Mapped Face Veshing
/1B Edge szng
8, Edgesing 2
8, Edgesing 3
- @ Named selectons
SR vl
i s
et
@ outet





image35.png
=4

aminar (1:5)

Fluent
CETELY
@ souton 2,
turbulent (1-6)

2@ v e
pse—

MK





image36.png
CFD Lab

File View Tools Units Extensions Help
INew EFopen... (o save B save ... | Gimport.
v R x

| “oRecomect @ Refreshproject 7 Update Project | @ Project. @) CompactMode

i - |

2@ oty 02 @ e v
e andrmard 8

Import Fiuent Case

Duplate
Transfer Data From New »
Transfer Data ToNew »

Mechanical Mode! Update

@ Mesh
[ Microsoft Offcecel
= polbfiow
Polyflow - Blow Molding
Polyflow -Extrusion

System Coupling

B Custom Systems

P Flid Flow (CFX)-> Static Structural
FS: Flid Flow (FLUENT) > Static Structural
Pre-Siress Modd

RandomVibraton

Response Spectnum

Thermal-Stress

@ DesignExploraion

@ DirectOptimizaton

Parameters Correlation

(2] Response Surfoc

@ Response Surface Optimizsion
SxSigma Analysis

T View Al Custonize.

@ Right-dicktoupdate componer:. (5 Srow progress || Show 5essages





image37.png
Dimension
E)
£

Disply Opios
Dispay Mesh After Reading
Embed Greptics Windows
Warkbench Color Scheme
[[] Do ot show this parel again

() Show More Dptions

Options
ouble Precision

Frocessing Optons
© Seral

Paralel

Concel ] [ Hep





image38.png
Meshing
Mesh Generation
Solution Setup.

Models
Materials
Phases
el Zone Conditons.
Boundary Condiions.
Mesh Interfaces
Dynamic Mesh
Reference Values
Soution
Solution Methods
Solution Controls
Monitors
Solution Iitlzation
Calaiation Activites
Run Calaation
Resuts
Graphics and Animatons
Plots
Reports

General

Mesh





image39.png
Meshing
Mesh Generation
Solution Setup.
focreral
Models
Materials
Phases
el Zone Conditons.
Boundary Condiions.
Mesh Interfaces
Dynamic Mesh
Reference Values
Soution
Solution Methods
Solution Controls
Monitors
Solution Iitlzation
Calaiation Activites
Run Calaation
Resuts
Graphics and Animatons
Plots
Reports.

General

=





image40.png
Mesting Models
Mesh Generation odels

Soluton Setup. [Matohase -OFf
General [Eneray ~Off
[Raciation -OFf
Materisls [Heat Exchanger -Off
Phases [Species -Off
el Zone Conditons | |Discrete Phase -OfF
Boundary Conditons || Soldficaton & Melting - OFF
Mesh Interfaces [Acoustics -Off
Dynamic Mesh
Reference Values

Soluton
Soluton Methods
Soluton Controls
Monitors
Soluton Intalzation
Calaaton Actvites
Run Caladation (Eat)

Resuits
Graphics and Animations
Plots b
Reports.





image41.png
Meshing
Mesh Generation
Solution Setup.
General
[Radton - OFF
Materials [Heat Exchanger - Off
Phases [species - OFF
Cell Zone Conditons | | Discrete Phase - OfF
Boundary Conditions | Soldification & Meltng - OFF
Mesh Interfaces (Acoustics -OFF
Dynamic Mesh
Reference Values
Soution
Solution Methods
Solution Controls
Monitors
Solution Iitlzation
Calaiation Activites
Run Calaation
Resuts





image42.png
Meshing
Mesh Generation
Solution Setup.
General
Models
Phases
el Zone Conditons.
Boundary Condiions.
Mesh Interfaces
Dynamic Mesh
Reference Values
Soution
Solution Methods
Solution Controls
Monitors
Solution Iitlzation
Calaiation Activites
Run Calaation
Resuts
Graphics and Animatons
Plots
Reports

Materials

T

Properties

Materal Type

Fluent Flid Materisls

[

Mixure

rane =

Density (m3) (congtant Edit

[changejcreate] |

e ] [ oo





image43.png
File Mesh Define Solve Adapt Surface Display Report Parallel View Help HOME INSERT DESIGN PAGELAYOUT ~REFERENCES MAILINGS REVIEW VIEW MathType ACROBAT  TimurKe.. -

Mesh Generation

Solution Setup.
General
Materials
Laminar flow
Mesh Interfaces
6.6. Solution Setup > Materials > air > Create/Edit. Change the density and viscosity as per
‘below and click Change/Create. Close the dialog box when finished.

Dynamic Mesh
Reference Values
Soution
Solution Methods
Solution Controls
Monitors
Solution Iitlzation
Calaiation Activites 0.008+00
Run Calaation Phase R

Eos ] - 000800

=
(Paranetae.. ] CATxED

Poraus Formulation 0.00e+00
uperfical Velocity 0.008+00

Physical Veloaty 0.008+00

(ko)

0.008+00

6.7. Add

Contours of Static Pressure (pascal) Jul 23,2013

S R I (b e, ) 6.8. Solution Setup > Boundary Conditions > inlet > Edit. Change parameters as per below

and click OK. (Note: Change inlet velocity to 0.2 ms for laminar flow)

writing outlet (type pressure-outlet) ~
writing zones map name-id ... Done.

oy Contions

iter continuity x-velocity y-velocity
* 1 solution is converged
1 0.0000e+00 ©.0000e+00 0.0000e+00

T -

varning: Flow boundary zone 7 is adjacent to po—

zone (2). This problem HUST be Fixeq g —
Solution can proceedt e —— =
warning: Flow boundary zone 8 is adjacent to r ——
zone (2). This problem HUST be Fixeq Pre—
Solution can proceedt ot ol [5257 =
Varning: Flow boundary zone 7 is adjacent to =
zone (2). This problem MUST be Fixeq [=[—]
— T

solution can proceed?

Warning: Flow boundary zone 8 is adjacent to Turbulent flow
zone (2). This problem HUST be Fixed |

solution can proceed?

i)





image44.png
‘s.ﬁm,bmlv

gy —

Reference Frame | wesh Moton| Porous Zone | Embected S| Reacton| Source Terms | Fee Vs | Mutphase |
‘This page is not applicable under current settings.

[Coc ] [conce] [ ]





image45.png
Meshing

Mesh Generation
Solution Setup.

Mesh Interfaces
Dynamic Mesh
Reference Values

Soution
Solution Methods
Solution Controls
Monitors
Solution Iitlzation
Calaiation Activites
Run Calaation

Resuts
Graphics and Animatons
Plots
Reports

Boundary Conditions

[ velocity Inlet

. e
[axis. [t
 —
rterr suface_body Momentum | Therma | Radaton | Species| oM | mtphase | uos |
&
e =T —
R -
Velocity Magnitude (m/s) 2 constant -
‘Supersonic/Initial Gauge Pressure (pascal) [ constant .
(o]
———————————
Phase Type fet®
(e ° o
(Faanets..
Display Mesh., | | Periodic Conditions... |





image46.png
Meshing
Mesh Generation
Solution Setup.
General

Mesh Interfaces

Dynamic Mesh

Reference Values
Soution

Solution Methods

Solution Controls

Monitors

Solution Iitlzation

Calaiation Activites

Run Calaation
Resuts

Graphics and Animatons

Plots

Reports

Velocity Inlet

Zone Name.

nterior surface_body
loutiet

‘-kt

Turbulence

Supersonic/lntial Gauge Pressure (pascal) [

Reference Frame (pscte
Velocity Magritude () 32,55

Mementm | Therna| Radaton| spece| 0P | Mutohase]| uos |
Veloty Specicaton ethod

Magritude, Norma to Boundary

Phase

= .

Turbulent Disspation Rate (m2/s3)

Specfication ethod (K ondEpsion =

Turbulent Kinetic Eneray (m252) [5.01

Edt...
Perameters... ] [Operating Conditons...

Periodic Conditons.

Display Mesh.





image47.png
Meshing
Mesh Generation
Solution Setup.

Mesh Interfaces
Dynamic Mesh
Reference Values

Soution
Solution Methods
Solution Controls
Monitors
Solution Iitlzation
Calaiation Activites
Run Calaation

Resuts
Graphics and Animatons
Plots
Reports

Boundary Conditions ) Pressure Outiet - ()
Zone Zone Name
foxe outet
et
Inferir surface_bod
Momentum | therma | Radaton | Species| 0o | wtphase | uos |
fat
e L
ekfon rectonspeccton bl [omal odoundary v
[ Average Pressure Specification
[ Target Mass Flow Rate
(=)
1008
Phase Tipe ®
110
(et ] (Copv.. |[Frofis...]
(Porametes... ) (Operating Conditrs... 1o1
[Display Mesh...] [ periodic Conditons. 0 100 200 300 400 500 GON





image48.png
Meshing
Mesh Generation
Solution Setup.
General

Mesh Interfaces

Dynamic Mesh

Reference Values
Soution

Solution Methods

Solution Controls

Monitors

Solution Iitlzation

Calaiation Activites

Run Calaation
Resuts

Graphics and Animatons

Plots

Reports

Boundary Con

Pressure Outlet

Zone Name.

Phase
mixture

Type

Bl o

‘mlkk

Wamentn | herme| Rodaton | speces| et

GeugePressure (ascal) (309 constant
mmmmmm:whw

| Mtphase | uos |

[ Average Pressure Speafication
[ Target Mass Flow Rate.
Turbuence
Speciication Method  znd Epsion
Backfon Tubulent KneticEnergy (n2/s2) [T [constant
Backfow Turbuient isspation Rate (n2/53) [ ——

(edt. ] (copy... ) profis-. ]

[Coc ] [conce] [ ]

Perameters... | [Operating Conditons..

Display Mesh.

Periodic Conditions.





image49.png
Meshing Boundary Conditions

Mesh Generation =
Solution Setup.
General
Models
Materials
Phases
el Zone Conditons.
Mesh Interfaces
Dynamic Mesh
Reference Values
Soution

Solution Methods
Solution Controls
Monitors )
Solution Initalzation Speaarity Coefficent

S e
Ferwiaadl - oe o

et = F
e Ce )

peprts (Fasnees..)

) (Peotic Conditors.. ]

Radation | Species| DPM | Mtphase | UDS | walFim|

voton
[IRelative to Adjacent CellZone

2565 constant -

05 constant -

[Coc ] [conce] [eb ]





image50.png
Meshing
Mesh Generation
Solution Setup.
General

Mesh Interfaces

Dynamic Mesh

Reference Values
Soution

Solution Methods

Solution Controls

Monitors

Solution Iitlzation

Calaiation Activites

Run Calaation
Resuts

Graphics and Animatons

Plots

Reports

Boundary Conditi

& Operating Conditions

Pressure =

Phase
(e ]

[ —

(et ] (Copv.. |[Frofis...]
(Porametes... ) (Operating Conditrs...
(Dislay Mesh...] [ Periodic Conditons... |

Operatng ressure (pascal)

[or22ss o
Reference ressure Location
X [

®
¥

o
(o)





image51.png
Meshing
Mesh Generation
Solution Setup.
General
Models
Materials
Phases
el Zone Conditons.
Boundary Condiions.
Mesh Interfaces
Dynamic Mesh

Solution Methods
Solution Controls
Monitors
Solution Iitlzation
Calaiation Activites
Run Calaation

Resuts

Graphics and Animatons

Reports

Compute from

Reference Values

Reference Values

|

Area (m2)
Density (kg/m3)

Length (m)

Temperature ()
Velocity (mfs)
Viscosity (kg/m-<)

Rati of Speciic Heats

[oo0z15989
2
EnthebyGha) [0
[ooszzs
Presseasca) g
E
foz
[1e72e05

14

Reference Zone





image52.png
Meshing
Mesh Generation
Solution Setup.
General
Models
Materials
Phases
el Zone Conditons.
Boundary Condiions.
Mesh Interfaces
Dynamic Mesh
Soution
Solution Methods
Solution Controls
Monitors
Solution Iitlzation
Calaiation Activites
Run Calaation
Resuts
Graphics and Animatons
Plots
Reports

Reference Values
Compute from

|

Reference Values

Area (02) [ 15386003

Densty Gaind) [1.17

Enthalpy (/ka) o
Length ()

Pressure (pascal) [
Temperatire 0) (255,15

Velocity (mfs)

Viscosity (ka/m<) (157205

Ratio of Speciic Heats [ 13

Reference Zone





image53.png
Meshing
Mesh Generation
Solution Setup.
General
Models
Materials
Phases
el Zone Conditons.
Boundary Condiions.
Mesh Interfaces

Solut
Pressure-Velocity Couping

ion Methods.

T

Spatil Discretization

radent
(Green-Gauss CelBased

F

Second Order
fum

Second Order Upwind
Turbulent Kinetic Energy
Second Order Upwind
Turbulent Disspaton Rate.
Second Order Upwind

Transient Farmuation

‘;‘

|

Non terative Tme Advancement
Frozen Fux Formulation
Pseudo Transient

[ High Order Term Relaxation
Defailt

I

3





image54.png
Mesting Solution Methods

o e
o[

=
o

= e

Cell Zone Conditions. feadent

el |[F=———

Second Order

‘g‘;‘

Second Order Upwind

Run Caladaton Transient Formulation
Resits
Graphics and Animatons | [~Tiion Sterative Time Advancement
i []Frozen Fiux Formuation
Reports [Pseudo Transient
[ High Order Term Relaxation

()





image55.png
Meshing
Mesh Generation
Solution Setup.
General
Models
Materials
Phases
el Zone Conditons.
Boundary Condiions.
Mesh Interfaces
Dynamic Mesh
Reference Values
Soution
Solution Methods
Solution Controls
Solution Iitlzation
Calaiation Activites
Run Caladation.

Monitors

Residuals, Statistic and Force Moritors

Istatistc - OfF

)

Surface Monitors

=3

(Crestere] [edt...| [peete|

Volume Monitors.

Residual Monitor Check Convergence Absolute Crteria

1006

1006

Iterations





image56.png
Meshing Monitors

Mesh Generation Residuss, Statisc and Force Maritors
Soluton Setup
po— Statstc-off
vodels
Vatersls
Phases
Cell Zone Conditons
Boundery Condtons | [Greate |
Mesh Interfaces
S, Surface Moritors
Reference Vaues
coton Ieratons to Sore
Solution Methods 1000 @
Solution Controls ~

Solution Initilization Create... | | Edit. Delete

Residual Wonitor Check Convergence Absolute Criteria

=3

o e Volume Monitors
Resuts

o ) [ rot ) (Renomsize) [ Goncel | [ ]





image57.png
Meshing
Mesh Generation
Solution Setup.
General
Models
Materials
Phases
el Zone Conditons.
Boundary Condiions.
Mesh Interfaces
Dynamic Mesh
Reference Values

009

Reset DPM Sources

Turbulent Knetic Energy (n2/52)

Turbulent Dissipation Rate (m2/s3)

(i) o

Reset Statstics




image58.png
Meshing
Mesh Generation
Solution Setup.
General
Models
Materials
Phases
el Zone Conditons.
Boundary Condiions.
Mesh Interfaces
Dynamic Mesh
Reference Values
Soution

Solution Methods
Solution Controls

Al Velodity (mfs)
02

Radial velociy (mfs)
0

(ot Reset ]

Reset DPM Sources | [Reset Statistics





image59.png
&2 Frturbulent (1e-06) Fluent [ax, dp, pbns, ske] [ANSYS Academic Teaching Advanced]
File Mesh Define Sove Adapt Surface [Display) Report Parallel View Help

CellZane Candtions 1
Boundary Conditions

Mesh Interfaces
Dynamic Hesh
Reference Valuss

Salution Methods
Salution Controls
Monitars

Salutian Intilization
Calclation Activites

Results
Graphics and Animations
Plats
Reports

H-d @[5S ¢ald

Meshing Run Calculation

Mesh Generation e
Solution Setup

General Humber of Terations

Hodels 100 |

Materils |

Phases Profie Update Interval

Data File Quantiies.

Salutian Caleate.

[E=E =

Mesh,

Graphics and Animations.

Plats.

Residuals.

Options
Scene
Views
Lights.
Colormap.

Annatate,

Zone Mation.
DTRM Graphics.

Irmport Particle Data,

PDF Tables/Curves
Reacting Channel/Curves,

Mouse Buttons,

Mesh

Jul 25,2013
ANSYS Fluent 14.5 (axi, dp, pbns, ske)

zones,
inlet
wall
axis
outlet
interior-surface_body
surface_body

Done..

Preparing mesh for display...
Done..

Done .

Setting Post Processing and Surfaces information ...
Reading “\"| gunzip -c \"C:\Users\nconger\Desktop\Lab 1_files\dpB\FLU-2\FLuent\SYS-1-1-00329..dat .gz\

Done..

= AEICICIELICIE

AR !




image60.png
&3 Furbulent (le-6) Fluent [ax, dp, pbns, ske] [ANSYS Academic Teaching Advanced] o= S

File Meh Define Sobe Adapt Surface [Display] Report Parallel View Help
Mesh,
Graphics and Animations.
Graphics and Anit
Graphics Residuals ol
Options. ey (o2
o silon
Pathines Scene
partde Tracks
Views. te400
Lights.
o Colorma
Vs et .
Dynamic Mesh Annotate o1
Reference Values
Soluton Snmatons Zone Motion.
Soluton Methods (Scene Animation DTRM Graphics. 1e04
Soluton Controls Souton Aimaton P
Monitors Import Particle Data.
Soluton Inlzaton PDF Tables/Curves 1o08
Calaation Actiies - . &
o e Reacting Channel/Curves
Results SetUp... touse Buttons
[sett... Mouse But P
Plots
Reports
1e-10
0 E3 50 75 100 125 180 175 200 25 250
Iterations
Scaled Residuals Jul 23, 2013
ANSYS Fluent 14.5 (ax, dp, pons, ske)
Building...
nesh
naterials,
interface,
donains,
mixture
zones,
outlet
inlet
axis
a1l
interior-surface_body
surface_body ~
Done..
Preparing mesh for display...
Done..
Setting Post Processing and Surfaces information ...  Done.
Reading “\"| gunzip -c \"H:\CFD\CFD Lab 1\CFD Lab 1 Solution Us_files\dp@\FLU-2\Fluent\S¥S-1-1-00250.dat.gz\"\"
Done..
| L





image61.png
Residual Wonior Check Convergence Absolute Crteria_
contnuty. 1006
x-velocity. 1006
yvelogty 1006
1006





image62.png
Residuals

%veloct
VElnc

Ensilon

:nmvvu

Scaled Residuals

1412

1e+00

1e02

1e04

1606

1008

1e-10

E3

50

75

100

125
Iterations

150

175

200

225 250

Jul 23,2013
ANSYS Fluent 145 (axi, dp, pbns, ske)




image63.png
i

Paste

&
Ep
«

Clipboard &

M H S N

HOVE| ISERT DESO pAGEAYOUT

Times New Ro -

D..

A g .y

T

AaBbCi AaBbCcDC AaEb(:D(F

Paragraph

7.1. File > Save Picture. Using option as per below save the residuals.

B save Pictre

Stytes

[

@
®
@
®
I
indow Dump Command
Window Dump mport indow %ow
Jsave...] Close | [ relp
[ WSS
il 3w
Veloc
G-
Postion (m)
v s 20

7.2. Surface > Line/Rake. Change x and y values as per below click Create. Repeat this for
more lines shown in the table

REFERENCES MAILINGS REVIEW VIEW MathType ACROBAT FORMAT TimurkKe.

i

Editing

JFluent Fluent
File] Mesh Define _Solve
Refresh Input Data

Save Project

Wiite

Import
Export

Solution Files...

Interpolats
EM Mapy
FSIMzpping

Save Picture.
Data File Quantities

Adapt _Surface Display Report Parallel View Help
[Haa s @Ls-0-
" 1: Scaled Residuals -
ulation
» JE—
, kGses ) [Freview esh vosen
) [lteations _ Reporting Interval
@ @
, ® ®
te Interval
@
©
, luantities... ] [ Acoustic Siondis
,
| =
R Seve Picture. Y B
Format
Oms @
e ®
el @
postsapt | ||150 200 250 300 3m0
= Options. llerations
P Lordscape Orinfation | Hindow Dump Conmend
vindow Dump | | [¥] White Background import indon %1 ]
(seve...] [apply ] (previen] [[Glose ) [k Jul 18,201
T

Tuent 14.5 (axi, dp, pbs, ske)

3

323
aou
325
326
327
328
329 s
329

writing

8460
16341
564
64
15
15
9040
9040

Done..

1.3150e-06
1.2926e-06
1.2229e-06
1.1707e-06
1.0867e-06
1.6159e-06
olution is converged
9.9183e-07 1.0527e-09 1.6054e-11 3
| gzip -2cfu > S¥S-1.cas.gz’
quadrilateral cells, zone 2, binary
2D interior faces, zone 1, binary.
2D wall faces, zone 5, binary.
2 axis faces, zone 6, binary.
2D velocity-inlet faces, zone
2 pressure-outlet faces, zone
nodes, binary.
node flags, binary.

2.0423e-09
1.8226e-09
1.6260e-09
1.4514e-09
1.2978e-09
1.1640e-09

3.1728e-11
2.8733e-11
2.5733e-11
2.3256e-11
2.0642e-11
1.8165e-11

7, bil
8, b

Writing “| gzip -2cfv > SYS-1-00329.dat.gz
Done..

4





image64.png
[ sove Picture LX)

FleType  Resoluton

Raster Width [565
Vector

Height 720

o @

L andscope Orintation | indow Durp Conmand

Wtesocgand | [t wndon |
(sove..) (aomy ) [preven] (Gose ) ((reb ]





image65.png




image66.png
Acfluid Flow (FLUENT) FLUENT [axi,dp, pbns, ske] [ANSYS Acader

ic Teaching Introductory]

File

H=-2d"

Mesh Define

Solve

Adapt _Surface

Q@ sfetnE-o-

Display _Report_Parallel

View Help

Problem Setup
General
Models
Materials
Phases
el Zone Contons
Boundary Condtions
Mesh Interfaces
Dynamic Mesh
Reference Values
Soution
Solution Methods:
Solution Controls
Monitors
Solution Iitlzation
Calaiation Activites
in Calaatior]
Results
Graphics and Animations
Plots
Reports

Run Calculation

Check Case... Preview Mesh Motion.

Number of Iterations__ Reporfing Interval
@ @
1000 3 =}
Profie Update Interval
1 @
=

T e ——
[Er—
(rep)

1: Scaled Residuals -

1e-06
Line/Rake Surface
2 1e-08
optons_Type Number of ops
. @
Line. ‘m 5]
1=t
Endponts
le-12
*0 () (05238 x1(m) [0.5238
a 50 100 150 200 250 300 350
¥o(m [o ¥1(m) [0.02619 "
Iterations
m(m);““““jjzxm)}““““*
SelctPonts with Howse
New SrfaceNome
o s Mar 11,2013
ANSYS FLUENT 13.0 (24, dp, pbns, ske)
Geste | [vansge..] (cose ] [ 06 3.6024e-07 4.8708e-11 5.27706-08 3.8554e-08 B
66 3.2520-09 4_567ke-11 5.2077e-08 3.6491e-08 0:00:05 68
uity x-velocity y-velocity k  epsilon tine/iter
320 1.29980-06 2.9250e-09 4_2u66e-11 5.1063e-08 3.4371e-08 0:00:04 680
321 1.2530e-06 2.6232e-09 3.0072e-11 4.9767e-08 3.2357e-08 0:00:03 679
322 1 2347e-06 2.3465e-09 3_6168e-11 4.8223e-08 3.0u0Re-08 678
323 100732-06 2.096ke-09 3.2773e-11 4_6476e-08 2.85uke-08 677
324 100432e-06 1.8684e-09 2.0795e-11 4_Us62e-08 2.6772-08 0:00:02 676
325 100363e-06 1.6656-09 2_68ge-11 4_2515e-08 2.5095e-08 0:02:16 675
326 1.0328e-06 1.4824e-09 2.4005e-11 4_03uSe-08 2.3kue-08 0:01:49 671
+ 327 solution is converged
327 9.4760e-07 1.3186e-09 2.1290e-11 3.9077e-08 2.1779-08 0:01:27 673
Writing “| gzip -2cfu > C:\Users\tdogan\Desktop\CFD Lab\pipe\pipe_files\dp@\FFF\Fluent\FFF-1.cas.gz
8460 quadrilateral cells, zone 2, binary.
16341 2D interior faces, zone 1, binary.
564 2D wall faces, zone 5, binary.
564 2D axis faces, zone 6, binary.
15 2D velocity-inlet faces, zone 7, binary.
15 2D pressure-outlet faces, zone 8, binary.
9040 nodes, binary.

9040
Done..

node flags, binary.

Writing *| gzip -2cfu > C:\Users\tdogan\Desktop\CFD Lab\pipe\pipe_files\dpO\FFF\Fluent\FFF-1-08327.dat .gz"
Done..





image67.png
B3 Afluid Flow (FLUENT) FLUENT [axi, dp, pbns, ske] [ANSYS Academic Teaching Introductory]

Fie Mesh Define Solve Adapt Surface Display Report Paraliel View Help

EAd: e Q@ sfetnE-o-

Problem Setup. Plots IR
General . Cptons ot Drecton
Hodsl
Node Vabes XT3
Materils e e e
Phases Fie = o el ety =
Cel Zone Concitons || Prfies: Csrwan
Clwnte tore X Functon
Soundary Condi Profe Data - Unavaisble
Soundery Condiers || e b order ponts [ Drecton vector =
e, maza 00 = e
Solution linteriorsurface_bod il
Soton Methods e
Sokton Controls
Monitors
Sokiton Intaizaton
Calaulation Activities i
Run Calaaton
s FrecOota | [NewSurfoce
Graphics and Arimations | (SeUpe
Pot ] (Ao ] [Gavess) (Gose ) (oo )
=)
1.00e+01
5.00e+00
0.00e+00 .
a 0.005 oo 0018 002 0.025 003
Position (m)
Axdal Velocity Mar 11,2013

ANSYS FLUENT 13.0 (2, dp, phns, ske)

325 1.0363e-06 1.6656e-09 2.6848e-11 4.25150-08 2.5095e-08 0:02:16 675
326 1.0328e-06 1.4824e-09 2.4005e-11 4.0345e-08 2.3440e-08 0:01:49 674
* 827 solution is converged
327 9.4760e-07 1.3186e-09 2.1290e-11 3.8077e-08 2.1779-08 0:01:27 673
Writing *| gzip -2cfu > C:\Users\tdogan\Desktop\CFD Lab\pipe\pipe_files\dpo\FFF\Fluent\FFF-1.cas.gz
8460 quadrilateral cells, zone 2, binary.
16341 2D interior faces, zone 1, binary.
564 2D wall faces, zone 5, binary.
564 2D axis faces, zone 6, binary.
15 2 velocity-inlet faces, zone 7, binary.
15 2D pressure-outlet faces, zone 8, binary.
9048 nodes, binary.
9040 node flags, binary.
Done..

Writing *| gzip -2cfu > C:\Users\tdogan\Desktop\CFD Lab\pipe\pipe_files\dpO\FFF\Fluent\FFF-1-08327.dat .gz"
Done..

Interrupting. ..
Done..

>
Interrupting. ..
Done..

>

< v





image68.png
AcFiuid Flow (FLUENT) FLUENT [axi, dp, pbns, ske] [ANSYS Academic Teaching Introductory] i i s

Fie e Define_Sove Adspt_Suface Dispiay_Report_Paralel_View _fidp
5 - W~ Qe si@nmm-o-|
Problem Setup. ‘Solution XY Plot 3
Gerers oo
ol Node Vaues
e
ey fizooan oo ani A
Colzone Condtions | s oo an ¥ s
Boundary Conditions: Profile Data -Unavailable [Clwrite to Fie:
Mesh Interfaces Interpolated Data Order Points
ynamic Mesh T
b e B8
Sdton
S ethods
Sduon Cotros
vorsars
Sduon ntslzaton
Calastan Acoutes
Ron Cacston
Results. [ FreeData |
Graphics and Animations | (Set Up.es
por | (s | [Gmes.
(rep)
1.00e+01
e e S B
K 5.00e+00
Curve #  Line Style. Marker Style
0.00e+00
a 0.005 oo 0018 002 0.025 003
Position (m)
Mar 11,2013

ANSYS FLUENT 13.0 (2, dp, phns, ske)

325 1.0363e-06 1.6656e-09 2.6848e-11 4.25150-08 2.5095e-08 0:02:16 675
326 1.0328e-06 1.4824e-09 2.4005e-11 4.0345e-08 2.3440e-08 0:01:49 674
* 827 solution is converged
327 9.4760e-07 1.3186e-09 2.1290e-11 3.8077e-08 2.1779-08 0:01:27 673

8460 quadrilateral cells, zone

16341 2D interior faces, zone
564 2D wall faces, zone 5, binary.
564 2D axis faces, zone 6, binary.
15 2 velocity-inlet faces, zone
15 2D pressure-outlet faces, zone

2, binary.
1, binary.

7, binary.
8, binary.

Writing *| gzip -2cfu > C:\Users\tdogan\Desktop\CFD Lab\pipe\pipe_files\dpo\FFF\Fluent\FFF-1.cas.gz

9040
9040

nodes, binary.
node flags, binary.

Done..

Writing *| gzip -2cfu > C:\Users\tdogan\Desktop\CFD Lab\pipe\pipe_files\dpO\FFF\Fluent\FFF-1-08327.dat .gz"
Done..

Interrupting. ..
Done..

>
Interrupting. ..
Done..

>





image69.png
1IENTY FLUENT Tavi dn nhne <kel TANSYE Academic Teaching Intraductornd
luid Flow (FLUENT) FLUENT [axi, dp, pbns, ske] [ANSYS Academic Teaching Introductory] - e - - =
Define Solve Adapt _Surf

play Report Porallel View Help

[=2d" I Qa M~-0o-
Plots
P L IANSYS
et Noncommercial use onh
sz 4.50e+01
Froie:
Frofe Data -Unavaiable
Interpolated Data 4.00e+01
e
Reference vabies 350e+01
sokton
Soton Methods
Solton Conoate 3.00e+01
Moritors
Sokiton Intaizaton
o Actuitics ) 2.50e+01
Run Calauaton Axial
Resuts Velocit 2.00e+01
Graphicsand Arimations | (SetUpus (m/s
Reports 1.50e+01
(reb)
1.00e+01
5.00e+00
0.00e+00
a 0.005 oo 0018 002 0.025 003
Position (m)
Axdal Velocity Mar 11,2013

ANSYS FLUENT 13.0 (2, dp, phns, ske)

325 1.0363¢-06 1.6656e-09 2.6848e—11 4.2515e-08 2.50950-08
326 1.0328e-06 1.4824e-09 2.4005e—11 4.0345e-08 2.34u6e-08

[ Solution XY Plot

es\dpB\FFF\Fluent\FFF-1.cas.gz"

PlotDirecton ¥ Axis Function
X Veloci

(il Velocity
X A Function
Direction Vector

v

Surfaces
[interor surface_body

lwal

ipe_files\dpONFFF\Fluent\FFF-1-00327.dat .gz"





image70.png
B3 Afluid Flow (FLUENT) FLUENT [axi, dp, pbns, ske] [ANSYS Academi = &

5 @0

File Mesh Define Solve Adapt Surfoce Display Report Porallel View Help

Q@ sfetnE-o-

Problem Setup
General

Models

Materials

el Zone Contons
Boundary Condtions

Dynamic Mesh
Reference Values
Soution

Solution Methods:
Solution Controls
Monitors

Solution Iitlzation
Calaiation Activities
Run Calaation
Results

Graphics and Animations

Reports

Plots [i:sttcresmre -]

— ;
Plots — « -Experimental 'f\iMSYS
Noncommercial use only|
stogram 2.20e+03
Fie
profies
Profe Data - Unavaisble
Interpolated Data 2.00e+03
=
1802+03
180e+03
1402403
Static
Pressure 1.20e+03
SetUp... (pascal)
100e+03
3
8.00e+02
£.00e+02
4.00e+02
B~ 0 ‘ T
optons Plt Drecton Y Axis Function Position (m)
Node Values X7 | [Pressre. =
Postionon X Axs
[Clpostonony axs || ¥[g ) |(SE0cesswre Y
Clwnte tore X Functon
Clorder ponts Drecton vector - Mar 11,2013
FieDsta 28 Surfoces 86 ANSYS FLUENT 13.0 (i, dp, pbns, ske)
e e-urfoce_body variable E
oute:
variable
variable
=
variable
]
variable

Error Object: xy/key/label/

Error: cx-var-value-set?: undefined variable

Error Object: xy/key/label/

Error: cx-var-value-sett
Error Object: xy/key/label/

Error: eof inside list

Error Object: ((xy/key/label/ “Experimental” 1.5 1863.333333 3.025 1486.666667 4.55 1120 6.075 744.3333333000001)

Error: Error reading file.

undefined variable

Error Object: “C:\Users\tdogan\Desktop\CFD Lab\pipe\pressure-EFD-turbulent-pipe.xy"

a

W & €




image71.png
xFluid Flow (FLUENT) FLUENT [axi, dp, pbns, ske] [ANSYS Acad

File Mesh Define Soive Adapt Suface Display Report Parallel View Help

Error Object: xy/key/label/

Error: eof inside list

Error Object: ((xy/key/label/ “Experimental” 1.5 1863.333333 3.025 1486.666667 4.55 1120 6.075 744.3333333000001))

Error: Error reading file.

S-d-mefsEaasfielnE-o-
Statc pressure
Problem Setup Plots -
oaxis NN
Genersl Plots — - -Experimental 'LWJ\I_SYS
s Noncommercial use only|
aterd Hstogram 220e+03
Cell Zone Conditons | profies:
ey Condtons roeamciona” 2.00e+03
Dynamic Mesh T
Reference Vaes 1.80e+03
Solton
Soluton Methods
gl 160e+03
Venitors
Soluton Intislzation
Calculation Activities " 140
Run Calaation Static
Resuts Pressure 1.20e+03
Graphicsand Arimations | (SetUpus (pascal)
frts 1.00e+03
=)
8.00e+02
6.00e+02
4.00e+02
0 4 7 8
Position (m)
Static Pressure Mar 11,2013
ANSYS FLUENT 13.0 (@, dp, phns, ske)
Error: cx-var-uvalue-se undefined variable =
Error Object: xy/key/label/
Error: cx-var-value-set?: undefined variable
Error Object: xy/key/label/
Error: cx-var-value-set?: undefined variable
Error Object: xy/key/label/
Error: cx-var-value-se undefined variable
Error Object: xy/key/label/
Error: cx-var-value-se undefined variable
Error Object: xy/key/label/
Error: cx-var-value-set?: undefined variable
Error Object: xy/key/label/
Error: cx-var-value-set?: undefined variable

Error Object: “C:\Users\tdogan\Desktop\CFD Lab\pipe\pressure-EFD-turbulent-pipe.xy"

a





image72.png
luid Flow (FLUENT) FLUENT [axi, dp, pbns, ske] [ANSYS Academic Teaching Introductoryl 0

Define Solve Adapt _Surf

Display _Report_Par

B o
Plots

pas et L AANSS

View Help

it Noncommercial use onl;
" 4.20e+01
Profes:
Profie Data - Unavaiable
Interpoiated Data 4.10e+01
=
Reference Vaes
Solton 4.00e+01
Soluton Methods
i 3.90e+01
Soluton Intislzation
Caladation Acties .
Run Calaation Axial 3.80e+01
Resuls Velocit
Gaptics and it | (setiin (m/s 3.70e+01
Reports
b, 360e+01
350e+01
340e+01
0 1 2 3 4 5 6 7 8
Position (m)

Axial Velocity Mar 11,2013

ANSYS FLUENT 13.0 (2, dp, phns, ske)

lution g
Beers SUSSEIEENIES

PlotDirecton ¥ Axis Function
X1 Velocity.

| =
A

— =

[— ElE] Surfaces 5]

[Velocity Magnitude (C:| et g

EEI—— H

loutet

wal

llpipe_files\dpoNFFF\Fluent\FFF-1-08327.dat .gz"

Done..





image73.png
Problem Setup
General
Models
Materials
Phases
Cell Zone Conditons.
Boundary Condiions.
Mesh Interfaces
Dynamic Mesh
Reference Values
Soution
Solution Methods
Solution Controls
Monitors
Solution Iitlzation
Calaiation Activites
Run Calaation
Resuts

Graphics and Animations

& Solution XY Plot
optons

Node Values
Positon on X Axis:
Positon on Y Axis
Virite to Fle
[ Order Points.

File Data 88

FreeData | [NewSurface

Write...

[(mes.. ] [curves...) dose | [[hep ]





image74.png
AcFluid Flow (FLL [axi, s, skel en Introductory] — e - — = @ 8
Fie Ve Define Sove Adapt Sufsce Display Report Paralll View el

ErHd-@e Sd @[ o-]

Problem Setup
General

Models

Veterils

Proses

Cell Zone Conditons
Boundary Conditons | [Parte Tracks
Vesh Iterfoces

Oynamc esh
Reference Vaues
Solton

Soluton Methods
Solton Controls Aninators
Mnitors

Soluton Inalzation | |Scene Anmation
o ataion | Sluon Arimaton Playback
Run Calaation
Resuts

Pots

Reports

vty
Min (mfs) Max (mfs)
[ |[aeme

2.44e+01
2.34e+01
2.25e+01

Velacity Vectors Colared By Axial Velocity (mfs) Mar 11,2013
ANSYS FLUENT 13.0 (@, dp, phns, ske)

Error: cx-var-value-set!: undefined variable
Error Object: xy/key/label/

Error: cx-var-value-sett: undefined variable
Error Object: xy/key/label/

Error: cx-var-value-sett: undefined variable
Error Object: xy/key/label/

Error: cx-var-value-sett: undefined variable
Error Object: xy/key/label/

Error: cx-var-value-sett: undefined variable
Error Object: xy/key/label/

Error: cx-var-value-sett: undefined variable
Error Object: xy/key/label/

Error: cx-var-value-sett: undefined variable
Error Object: xy/key/label/

Error: eof inside List
Error Object: ((xy/key/label/ “Experimental” 1.5 1863.333333 3.025 1486.666667 4.55 1120 6.075 744.3333333000001)

Error: Error reading file.
Error Object: “C:\Users\tdogan\Desktop\CFD Lab\pipe\pressure-EFD-turbulent-pipe.xy"





image75.png
AFluid Flow (FLL [2xi, dp, pbns, ske]

Introductory]

Fie Mesh Define Solve Adapt Surface Display Report Parallel View Help

ErHd-@e Sd @[ o-]
Problem Setup Graphics and Anim:

Gerera o

vodes i

Voterss =

Prases mo

ol Zone Conitions | [Patrines

Soundory Conditons | [Paric Traks

Ve Terfaces

Dynamic Hech

Refeence vaes e
Solution

St etrods

prinations

Solution Controls

Monitors >

Solution Iitlzation Scene Animation
Calaiation Actvities Soution Arimation Playback

1: Veloity Vectors Colored 8 +

Run Calaiation 0es01
Resuts 3.20e+01
o
Plots B+
Setlp...
Reports 3.01e+01
(oo 2926401
Cugie) 2826401
2.738+01
(Fen) 2638401
2538401
2448401
2348401
= 2258401
Vectors of
liclocity, L Velocity Vectors Colored By Axial Velocity (m/s) Mar 11,2013
Color by ANSYS FLUENT 13.0 (axi, dp, pbns, ske)
Veloty. =
Error: cx-var-uvalue-se undefined variable =
(futal elooty, > Error Object: xy/key/label/
Min (mfs) Max (mfs)
24792 H‘Msv@s Error: cx-var-value-set!: undefined variable
Error Object: xy/key/label/
Surfaces EIE}]
fxs B Error: cx-var-value-sett: undefined variable
inlet Error Object: xy/key/label/
It urface_body H
[outiet Error: cx-var-value-set?: undefined variable
o o Error Object: xy/key/label/
x=10d -
Error: cx-var-value-se undefined variable
Error Object: xy/key/label/
Surface Types 88 Error: cx-var-value-set!: undefined variable
jaxis A Error Object: xy/key/label/
diput 3
|exhaust-fan Error: cx-var-value-set?: undefined variable
ffan Z Error Object: xy/key/label/
Error: eof inside list
Error Object: ((xy/key/label/ “Experimental” 1.5 1863.333333 3.025 1486.666667 4.55 1120 6.075 744.3333333000001))

Error: Error reading file.
Error Object: “C:\Users\tdogan\Desktop\CFD Lab\pipe\pressure-EFD-turbulent-pipe.xy" B

a





image76.png
AcFiuid Flow (FLUEI

[axi, dp, pbns, ske]

ic Teaching Introductory]

=g ® |

Fie Mesh Define Solve Adapt Surface Display Report Parallel View Help

(5~ - @O

Q@& s &0

Proem et Grap! ===
General R— Contours of
Vadels ey vebaty... -
Vateris
Phases ectors sl velodty =
Cellzone Concitons | [Patines ) )
Zuu:d‘avécfundmuns [Partide Tracks. Dchmeange OO ’W
e nterfaces Oraw profies
Omamcren [loraw Hesh Surfaces
Setlp... =
Sohton = e
Solton Methods ok sew e by
o o Aninstions » B outet
Souton Contro S| ® |wal
Soton ntsiaton | [Scredanater i
Calaaton Actvites | |50t Animation Payba Surfoce Name Pattem [New Sufacer
e — O
e |l
fpsuf
Pots et fan @
Reperts [setwe..] o B
Optons... ) (_Scene... ) [_views.. =
tghts..._) (Cdomp...| motete..] [oose J
=)
6.248400
4462400
2088400
0.00e+00
Contours of Axial Velacity (ms) Mar 11,2013
ANSYS FLUENT 13.0 (i, dp, pbns, ske)
Error: cx-var-valueset!: undefined variable
Error Object: xy/key/label/
Error: cx-var-value-set!: undefined variable
Error Object: xy/key/label/
Error: cx-var-value-set!: undefined variable
Error Object: xy/key/label/
Error: cx-var-value-set!: undefined variable
Error Object: xy/key/label/
Error: cx-var-value-set!: undefined variable
Error Object: xy/key/label/
Error: eof inside List
Error Object: ((xy/key/label/ “Experimental” 1.5 1863.333333 3.025 1486.666667 4.55 1120 6.075 744.3333333000001)
Error: Error reading File.
Error Object: "C:\Users\tdogan\Desktop\CFD Lab\pipe\pressure-EFD-turbulent-pipe.xy”
iter continuity x-velocity y-velocity K epsilon  time/iter
+ 328 solution is converged
328 8.6516e-07 1.1748e-09 1.8755e—11 3.5743e-08 2.0126e-08 0:01:43 1000
+ 329 solution is converged
320 8.2810e-07 1.0528e-09 1.6403e—11 3.3374e-08 1.8501e-08 0:01:23 999
2R S 2% T "™ "L Cmoe





image77.png
T2, s, skel

Introductory]

=8 ®

File Mesh Define Solve Adapt Surface Display Report Paraliel

Qa0

View Help

Problem Setup.
General
Models
Materials
Phases
Cell Zone Conditons.
Boundary Condiions.
Mesh Interfaces
Dynamic Mesh
Reference Values
Soution
Solution Methods
Solution Controls
Monitors
Solution Iitlzation
Calaiation Activites
Run Calaation
Resuts
Plots
Reports

Pathines
Partice Tradks.

SetUp...

Animatons

Scene Animation
Soution Arimation Playback

1: Contours of Axial Velocity +

6.242+00
4182400
2.08e+00
0.00e+00

Contours of Axial Velacity (mis)

Mar 11,2013
ANSYS FLUENT 13.0 (2, dp, phns, ske)

Error:

Error:

Error:

Error:

Error:

Error:

Error:

iter
1 328

328
[

320

cx-var-value-sel

cx-var-value-sett

cx-var-value-sett

cx-var-value-sel

cx-var-value-sel

eof inside List

Error reading file.

continuity x-velocity
solution is converged
8.6516e-07 1.1748e-09
solution is converged
8.2810e-07 1.0528e-09

undefined variable
Error Object: xy/key/label/

undefined variable
Error Object: xy/key/label/

undefined variable
Error Object: xy/key/label/

undefined variable
Error Object: xy/key/label/

undefined variable
Error Object: xy/key/label/

y-velocity K epsilon
1.8755e-11 3.5743e-08 2.0126e-08

1.6403e-11 3.3374e-08 1.8501e-08

Error Object: ((xy/key/label/ “Experimental” 1.5 1863.333333 3.025 1486.666667 4.55 1120 6.075 744.3333333000001)

Error Object: “C:\Users\tdogan\Desktop\CFD Lab\pipe\pressure-EFD-turbulent-pipe.xy"

time/iter
0:01:43 1000

0:01:23 999





image78.png
/\ CFD Lab 1 Student - Workbench L Y - - i %
File View Tools Units Extensions Help

TINew 5 open.. [l save [l save ss... | flimport.

“oRecomect @ Refresh Project 7 Update Project | (3project () Compact Mode

voRx

8 Anlysis Systens
Design Assessmet

® Eeanc

ExplictDynamics

@) Flid Flow- Blow Molding (Polyfov)
(@) Fluid Flow- Extrusion(Polyflov)
@ Flid Flow(cR)

) Flid Flow (Fuent)

(@ Fluid Flow (Polyflow)

(@ HermonicResporse

4 1cEngine

LinearBucking

Magnetostaic

@ vodal

) Randomvibraton

) Response spectnm

& Rgidoynamics

@ Stic tructurel
@ Steady-State Thermal Contnue Caladation
@) Themal Electric InportFinalData,
& Trensient Structural
) Transient Thermal Dupliate
B ComponentSystams Transfer Data FromNew >
© Autodn TransferDataTolen
@ o . V.
& Engincering Data wias Upda o
% Exteral Connection Clear Generated Data

Extemal Data Refiesh
@ Finite BementModeler Reset

Rename

B Fluent (vith TGrid meshing) -2}
@ Geometry - 3 k| Propertes
& o : CEEE i

Mechanical APDL 2 @ Importedvesh v ———e2 @ setwp P
@ MechanicalModel © ot
@ vesh Grd2 -
[ Microsoft Officebcel Laminar (12:5)

Folyfiow
Polyflow-BlowMolding
=i Polyflow-Bxrusion
@ Reslts

System Coupling

Custom Systems
Design Bxploration

T View Al Customize...

@ Double-lck componentto edt





image79.png
B2} B:Laminar (1e-6) Fluent [axi, dp, pbns, lam] [ANSYS Academic Teaching Advanced]

Fie Mesh Define Solve Adapt Surface Display Report Paraliel View Help

[=hd" Rdc Q& s @8- O~
Plots
ots confRER2°
Zyee
— VEIDEn p—
Fie
profies: Te40
Profie Data - Unavaiable
Interpoleted Data
= 1601
1602
Dynamic Mesh
Reference Values o3
Soluton
Soluton Methods Te04
Solution Controls
Moritors 1e05
Soluton Inlzaton
Calaation Actiies 0B
Run Caladation setUo.
Results 1e07
Graphics and Animations
(rep) 1ot
Reports
1609
0 50 100 180 200 250 300 350
Iterations
Scaled Residuals Jul 19, 2013
ANSYS Fluent 14.5 (ax, dp, pons, lam)
iter continuity x-velocity y-velocity  time/iter
320 1.8464e-06 1.1970c-06 1.0368e-09 0:00:03 680
321 1.9260e-06 1.1688e-06 1.8975¢-09 679
322 1.8593e-06 1.141%e-06 1.8570e-09 678
323 2.0917e-06 1.11uke-06 1.8179-09 677
324 1.64870-06 1.0885e-06 1.7859¢-09 676
325 1.49970-06 1.0630c-06 1.7452e-09 675
326 1.4951e-06 1.0373e-06 1.7033e-09 671
327 1.38M5e-06 1.0131e-06 1.6710e-09 673
328 1.5314e-06 9.8906e-07 1.6364e-09 672
329 1.2633e-06 9.6587e-07 1.6014e-09 67
330 1.1602e-06 9.431ue-07 1.5663e-09 0:00:uh 670
iter continuity x-velocity y-velocity  time/iter
831 1.6732¢-06 9.20u8¢-07 1.5323¢-00 0:00:35 669
332 1.1401e-06 8.9914e-07 1.5035e-09 668
333 1.0693e-06 8.77500-07 1.4674e-09 667
334 1.50220-06 8.5698e-07 1.4399e-09 666
335 1.15260-06 8.3702e-07 1.u121e-09 665
336 1.10260-06 8.1671e-07 1.3824e-09 661
337 1.3848e-06 7.9777e-07 1.3501e-09 663
* 338 solution is converged
338 9.6066e-07 7.7862e-07 1.3204e-09 0:00:07 662

1

7 oM = DIRIEINFE

21PM
n9/2013 |





image80.png
B FiLaminar (1e-6) Fluent [axi, dp, pbns, lam] [ANSYS Academic Teaching Advanced] = ®
Fle Mesh Define Solve Adspt Suface Display Report Paralll View Ficlp
Bs-d-mofsEaasfainm-o-
o 1 Al Velogty. =
Vesh Generation e
Soluton Setup
Gereral istogram
Models [Fie.
profies:
Materials Profile Data - Unavailable
Phases Interpoiated Data
Cellzone Conditons | |FFT ¥ s Functon
Boundary Conditons
Mesh Interfaces
Dynamic Mesh ol velcty =
Reference Vaues S o
Solton Drecton Vector -
Soluton Vethods -
Monitors a
Soluton Intislzation
Calaiation Acties
Run Calauaton Setipn
Resits .
Sostes s smstors | ] el - o
Reports. Free Data [New Surface v .
0.00e+00
0. (write... ] [Axes.. | [curves...] [ Close Help. 0.04
Axial Velocity Jul 23,2013
ANSYS Fluent 14.5 (axi, dp, pbns, lam)
> (cx-gui-do cx-set-real-entry-list "Point SurfacexFrame2(Coordinates)*Frame1xTable1*RealEntry2(y8)” *( 0.824))
> (cx-gui-do cx-activate-item "Point SurfacexPanelButtons*PushButton1(OK)")
> (cx-gui-do cx-set-text-entry “Point SurfacexTextEntrys(New Surface Name)" “point-16")
> (cx-gui-do cx-set-real-entry-list “Point SurfacexFrame2(Coordinates)*Frame1xTable1*RealEntry2(y8)” *( 0.825))
> (cx-gui-do cx-activate-item "Point SurfacexPanelButtons*PushButton1(OK)")
> (cx-gui-do cx-activate-item "Point SurfacexPanelButtons*PushButton2(Cancel)")
> (cx-gui-do cx-activate-item “HenuBar=iriteSubMenuxStop Journal™) -
N 4

w D





image81.png
B FiLaminar (1e-6) Fluent [axi, dp, pbns, lam] [ANSYS Academic Teaching Advanced] = ®
Fie WMesh _Define_Soive Adapt _Surface_Display_Report_Paallsl_View _Felp
Bs-d-mofsEaasfainm-o-
Prots 3 ol Vlocty =
Mesh Generaton o
Sobton setup
General |Histogram Select
Models: [Fie
Froies:
Waterials Profie Data - Unavaiable Lookin: | Jj CFDLab 1 - @@ mr
Phases Interpolated Data. -
Cel Zone Concitons | |FFT o Neme Datemodfied  Type
Soudary Condors B CrD Lab 1 Template fies TALBILSEAM  File older
; Recent Places | sy dent CFD Lab1 AR 012AM  Fiefolder
Reference Vabes
sokton
Soton Methods
Sokton Controls
Monitors
Sokiton Intaizaton
Caloaton Actites
Run Calaaton Settp.e
Resits
Graphics and Anmations [ ——
=)
0.00e- <[ . ] >
XYHe elocty Profe Grd 4 -] oK oot
Flesoltpe: (XYl 3 Cancel.
Axial Velocity Jul 23,2013

ANSYS Fluent 145 (axi, dp, pbns, lam)

> (cx-gui-do cx-set-real-entry-list “Point SurfacesFrame2(Coordinates)xFrameixTableisRealEntry2(y0)” *( 0.024)

> (cx-gui-do cx-activate-item “Point SurfacexPanelButtonsxPushButton1(0K)")

> (cx-gui-do cx-set-text-entry "Point SurfacexTextEntry(New Surface Name)” “point-16"

> (cx-gui-do cx-set-real-entry-list “Point SurfacesFrame2(Coordinates)xFrameixTableisRealEntry2(y0)” *( 0.025)

> (cx-gui-do cx-activate-item “Point SurfacexPanelButtonsxPushButton1(0K)")

> (cx-gui-do cx-activate-item “Point SurfacexPanelButtonsxPushButton2(Cancel)”)

> (cx-gui-do cx-activate-item “MenuBarxiiriteSubMenuxStop Journal®)





image82.png
]
il

)0 b CRDLabl »,

Organize + [ Open  Bum  Newfolder
Neme

L enau

[ Gria2

[ Griaa

) Grigs

[ Grigs

[ Grid7

¢ Favorites
B Desktop
& Downloads

) Recent Places

5 Ubrares
5 Documents

File Edit

(title
(labels,

Intermedate Lab #1 Manual V3 docs
Intermedate Lab #1 Manual Vi docs

Format_View Help (=) Pictures Intermediate Lab #1 Manual V5.docx

Ic xial velocity H Videos

k1 verocity ) Labt veociyProieScipt
V8 for pipe flowsx

[ velGria2

s . || Vel Grid 3

poinc-1")

@n L] vel Gridd

Copy fied: 7, 441PM Date created:
Paste 541 bytes

Delete.

dified

5 PM

]
Select Al B oo
WB Vaviorar
Right o lef Reading order -
Show Unicode control characters menGaidoc
Insert Unicode controlcharacter
OpenME

Reconversion

2

Template.
W forpi

=N

558 PM
1B/2013




image83.png
[z]

ViAo 0 (S10]

File Edit Format View Help

(ritle "axial velocity”) 3
Clabels "position” "axial velocity")

((xy/key/1abel "point-1"
$ xy/key, P
((xy/key/1abe] "point-10"
0025 0.0352328
((xy/key/1abel "point-2"
9005 0. 383509
((xy/key/1abel "point-3"
0.01 0.339995

‘< 3

v CPDLabl »
Organize [ Open  Bum  Newfolder
P e
B Desktop ] Grid2
1 Downloads [ Grez
] Recent Places [ eriat
] Grids.
5 Libraries ] Grd7
o=y @ Intermediate Lab #1
o Music Intermediate Lab #1
Pictures Intermediate Lab #1
H Videos ] Labt Velocity Profile
5 V& for pipe flowasds
Computer [ Vel Grid2
& system (@) [ Vel Grid3
o Local Disk (D) [ Vel Grids

B

<
it

Vel
File

Grid 4 Date modified: 7/23/2013 4:41 P
Size: 541 bytes

BES o -

HOME  INSERT

Template VAW for pipe flowisx - Excel

? =

- o

x
PAGELAOUT  FORMULAS  OATA  REMEW  VEW  ACROBAT Tom Mchaein. - [

o X [cabn  -Ju - Number +| FZ)Conditionsl Formatting = Belnsent = 3 - A7~
N D Ba- B I U- A A [ Format as Table = E¥Delete - [~ #h~
e DA~ 57 Cel Styles - Eiformat- £+
Clipboard Font G Agnment G Number stes ceis Editing -
- £ v
A B c D E F G H 1 J K L[4
1
2 Insert results from velocity values from your simulation into the yellow region (number corresponds to grid number’
3
4 2
5 4142136
6 Grids 2,3,4
7
s 0 | 03se713 0.400000 | 100.000000(100.000000] 0.000000 [ 0.000000 [ #DIV/o!
) 0.005 0.385000 [ [100.000000(100.000000] 0.000000 | 0.000000 [ #DIV/0}
10 0.01 0.342000 [ [100.000000(100.000000] 0.000000 | 0.000000 [ #DIV/0}
1 0.015 Paste Options: o [ 100.000000(100.000000] 0.000000 [ 0.000000 [ #DIV/0!
12 0.02 - o [ 100.000000(100.000000] 0.000000 [ 0.000000 [ #DIV/0!
13 0.021 A o [ 100.000000(100.000000] 0.000000 [ 0.000000 [ #DIV/0!
14 0.022 (o M‘Omy ) | e-118000 100.000000(100.000000] 0.000000 | 0.000000 | #DIV/0!
15 0.023 0.092000 100.000000(100.000000] 0.000000 | 0.000000 | #DIV/0!
16 0.024 0.064000 [t [100.000000(100.000000] 0.000000 | 0.000000 [ #DIV/0}
7 0.025 0.036000 [#s##[100.000000[100.000000] 0.000000 [10.000000 [ #DIV/o:
1
19
20 Axial Velocity Profile
21 1200000
2
5
2%
s 1000000
%
z
= 0.800000
2
20 z =
31 £ 0.500000 ——se1
2 2 —
3
o —ses
. 0.400000
3%
7 =
“« V&V Velocity | Verfiication Friction | () {1 — o]





image84.png
N CFD Lab 1 Student - Workbench - - - = B

File View Tools Units Extensions Help
e open... el ssve [ save fs.. | Glimport..

L]
B Analysis Systems

Design Assessmert

® Eectric

ExplictDynamics

6 Fluid Flow- BlowMolding (Poyfw)

@ Fluid Flow- Eerusion Folyflow)

@ Fluid Flow(cPQ

@ Fluid Flow (Fluent)

(9 Fhid Flow (Polyfiow)

(@ HarmonicResponse

&4 1cengine Clear Ol Soluton Data
LinearBucking
Magnetostatc

@ Model

) Rendomvibraton
) Response Spectnm
(& Rigid Dynamics

@ Stic tructurel

) Stesdy-State Thermal
@) Themal Electric

& Trensient Structural
) Transient Thermal

& ComponentSystems
© Autodn

@ o

@ Engineering Data Laminar (1t
% Exteral Connection
Extemal Data

@ Finite BementModeler
B Fuent - ®

“oRecomect @ Refresh Project 7 Update Project | (3project () Compact Mode

Continue Caladation
Import Final Dat.

Duplate
Transfer DataFromNew >
TransferDataToNen b
7 Update
Clear Generated Data
Refresh

w

i

> e
:f;;'; 2 @ ImportedMesh
I\ Mechanical APDL Grid3
@ Mechanical Model
@ Mesh
[ Microsoft Officebxcel
2 Polyflow
3 Polyflow-BlowMolding
Polyflow-Extrusion
© Resslts

System Couplig
Custom Systems. Grid 2 3
Design Exploration

: B 1
2| @ ImportedMesh v ———e2

a4 ey L E— L ew— =
@ Double-click componentto edt.





image85.png
8:Laminar (1e-6) Fluent [axi, dp, pbns, lam] [ANSYS Academic Teaching Advar = B HS 0= ‘manual.docx - Word
Fie Mesh Defne Sove Adapt Suface Display Report Parall View Hep HOME | INSERT | DESIGN PAGELAYOUT  REFERENCES  MALINGS REVIEW \VIEW MatiType ACROBAT Michaeia.. - [
B -H-B0SEHAA /@ NE-0- OlE=E DD $ 38 [y Drew 4l o
1 ScoledResdl 3 ld < = D Footer-
Meshing Plots Pages Table Pictures Online Shapes Appsfor Online  Links  Comment Text  Symbols Embed
Mesh Generation p— - - Pictures - @+  Office~ Video  * [A) Page Number- ~ Flash
soton et Tabies Iustatons Ao wean Comments  Heaver & Footer Fissn ~
General ristogrem . g 1 2 3 . B
odes Frfies —
Materials Profie Data - Unavailable:
i InterpotedDoa [ —
ColZone Condtions | [T
Saundary Condtons
Mesh Interfaces [ Solution XY Plot
Dynamicesh -
Reference vabes || optons 5o
= = |
Sooton etrods oson an X A i
Sooton Controts oo an ¥ s
Monitors Wirite to Fie
Solution Initialization Order Points.
Calastan Acoutes (o)
Run Calculation Fie Data B8 Surfaces. E[E|
¢ = recown
raphics and I nterorutace_body Do (e (@ovee) (e ) (oo )
Name the file according to grid and convergence limit and save to project folder.
150 200 250 300 350 gto8 8 proj
= B terations
- ofem
vite ) (s | [Grvesn) (o | (oo - onemostes e
ot e,
caled Residuals Jul 22,2013

ANSYS Fluent 145 (axi, dp, pbns, lam)

iter continuity x-velocity y-velocity |-
320 1.8464e-06 1.1970e-06 1.9368e-09
321 1.9269e-06 1.1688e-06 1.8975e-09
322 1.8593e-06 1.1414e-06 1.8570e-09
323 2.0917e-06 1.1144e-06 1.8179-09
324 1.6487e-06 1.0885e-06 1.7850e-09
325 1.4997e-06 1.0630e-06 1.7452e-09
326 1.4951e-06 1.0373e-06 1.7033e-09
327 1.38k5e-06 1.0131e-06 1.6710e-09
328 1.5314e-06 9.8906e-07 1.6364e-09
329 1.2633e-06 9.6587e-07 1.6014e-09
330 1.1602e-06 9.4314e-07 1.5663e-09
iter continuity x-velocity y-velocity
331 1.6732e-06 9.2048e-07 1.5323-09
332 1.1401e-06 8.9914e-07 1.5035e-09
333 1.0693e-06 8.7750e-07 1.4674e-09
334 1.5022e-06 8.5698e-07 1.4399e-09
335 1.1526e-06 8.3702e-07 1.4121e-09
336 1.1026e-06 8.1671e-07 1.3824e-09
337 1.3848e-06 7.9777e-07 1.3501e-09

+ 338 solution is converged
338 9.60660-07 7.7862e-07 1.3204e-09 € |

=]

4

w = g





image86.png
0 H 9 O B siominar (1) Fluent o, op, pbns, lam] [ANSYS Academic Teaching Advanced]

le/@ =
FILE HOME File Mesh Define Solve Adapt Suface Display Report Parallel View Help
ﬁxcm o sEHaas «iE-0-
ER Copy
y Lo 3
Paste eshng Plots
+ ¥ Format Pai s enera
lipboar Select
Clipboard Solution Setup:
. Fstogram
ey e ook ), e - e rmr
s
Heterds Profie Data - Unavaiable Date modified iType
Interpolated Data No items match your search.
& Solution XY Plot. -
PotDrecon
Node s || X[7
oo on A
[|Position on ¥ Axis.
e toFie
Order Points [0
28
<[ . ]
(Londrie..] XFe WSS 7]
Fecoin]  pewsey Fescitpe: (XYl T )
Wesh au123,2013
Wiite... | [Axes.. | [Curves...] [ Cose | [ rep | ANSYS Fluent 14.5 (axi, dp, pbns, lam)
materials, N
interface,
donains,
mixture
Suttet
inlet
axis
ol

Done..

Done..

Done .

<

interior-surface_body
surface_body

Preparing mesh for display...

Setting Post Processing and Surfaces information ...
Reading “\"| gunzip -c \"

Done..

:\Users\nconger\AppData\Local\Tenp\CFD Lab 1 Student.tmp\CFD Lab 1 Student_files\dpo\FLU-17\Fluent\grid7-4-

m

i





image87.png
I H ©- O vaviorppet
Ho |INSE PAG FOR DAT REVI VEE ACR Tea Mid>

® (A [= 9% | | FB)Condtional Formatiing
£ Format as Table -
s o A o B
- - " = fes~ —
< el » & ‘ i | Wall Sherar Stress Grid . =
Styes - .. L
o File Edit Format View Help
62 < £ v (title "wall shear stress™) -
Qlabels "Position” "wall shear stresi|
A 8 c [ 3 ] ((xy/key/label "wall™)
1 7.62
7059619 0.0005714¢ (40
2 Insert friction values into the yellow 7.57237 00005717
3 7.54856 0.0005713;
7.52475 0.0005715(  Cut
4 Pgest | 2.00000 7.50004 0.0005714] ¢
5 g Laaa1 7.47713 0.0005714 i/
7045331 0.0005714{  paste
[ [rids2.34  sg1 sg2 g3 7.4205 0.000571a1  ©
7.40569 0.0005714
7 0.00000_| 0.00000 | 0.00000 | 0. 7-40058 0 000ai1d
8 [orids6,7,4  sg1 sg2 g3 7.35806 0.0005714(  SelectAll 1
9 0.00000_| 0.00000 | 0.00000 | 0. 733425 0.0005714
© . L FighttoleftReading order [
u Show Unicode control characters
o pgest | 200000 Insert Unicode control character » E
13 e 2.00000 OpenIME g
1 [Grids 0,24 sg1 sg2 g3 IR
15 0.00000_| 0.00000 | 0.00000 | 0. k
16 [Gridsa.64  sg1 sg2 g3 u :
% 0.00000_| 0.00000 | 0.00000 | 0.
18
19
20 :
grid | wall shear ‘ :
2 # stress <
2 n- 0.000000
B ‘0.000000 i

o LA lalnlalalkal o





image88.png
BHS @ =

Template V& for pipe flowadst - Excel

| - x
ichad Atony Conger - [

ﬁg;z'w . Calibri A A ==E 9 SwmTe General B 7] Good s il E:Hm‘m “Ay
B Sramarana BT U E A S5 Bessaco - S5 W G T e IR
2R z .
.
: | i sino ol egrs
:
:
.
6 Grids 2,3,4] 5g3 A Eg2[%]  Eg3[%]  Egal%] e21 e32 Rg. Pg. delta cg Ugl%]  Ugcl%]
7 0.000E+00]0.000+00|0.000+00|9.775€-02| 1.000E202 | 1.000E+02 | 1.000E=02 | 0.000+00  0.000E+00 DIv/o!
8 Eg2[%]  Eg3l[%]  Egal%] Rg. Pg. delta cg ug Ugc [%]
9 0.000E+00 | 0.000E+00 | 0.000E+00 | 9.775E-02| 1.000E+02 | 1.000E+02 | 1.000E+02 | 0.000E+00 | 0.000E+00 [ #DIV/0! | #DIV/0! [ #DIV/0! [ #DIV/0! #DIV/0!
-
i (-
E
E
14 Keep Tt Only (1) = Eg2[%]  Eg3[%]  Egal%] Rg. Pg. delta cg Ug [% Ugc [%]
15 0.000E+0L) oo rom [ o-bdE+00 | 9.775E-02| 1.000E=02 | 1.000E=02 | 1.000E=02 | 0.000E+00  0.000E00 DIv/o!
17 0.000E+00 | 0.000E+00 | 0.000E+00 | 9.775E-02| 1.000E+02 | 1.000E+02 | 1.000E+02 | 0.000E+00 | 0.000E+00 [ #DIV/0! | #DIV/0! [ #DIV/0! [ #DIV/0! #DIV/0!
-
E
Wall
Grid Shear <
20 Stress.
H
=
30 =8*T/(r*Un2).
H
e
=
H U

| vaw velocity





image89.png
BHS @ =
GOl oM mser
Hcut

B2 Cory ~

Paste B
T S Formatpainter B T U

PAGELAYOUT  FORMULAS

Calibri MEEME Y
ENFTe

Font 5

Clipboard 5

c26 M £

DATA

=g

Alignm

REVIEW

VIEW

ACROBAT

Team

Template V& for pipe flowadst - Excel

B Wrop et

General

Merge & Center ~

ent 5

$-%

Number

Conditional Format as
Formatting = Table ~

Check Cell

5 Stytes

&=

Insert Delete Format

i

cells

| - x
ichad Atony Conger - [

A
oy ik
Soté Find&
Fiter~ Select~

Edting -

S AutoSum -

e

& Clear~

g3 A
0.000€+00] 0.000£+00[0.000E+00|9.775E-02|

0.000€+00[ 0.000£+00[0.0008+00]9.775E-02|

Eg2 [%]

1.000+02
Eg2 [%]
1.000E+02

Eg3 [%]

1.000+02
Eg3 [%]
1.000E+02

Ega [%]

1.000+02
Ega [%]
1.000E+02

e21
0.000E+00

0.000E+00

e32
0.000E+00

Rg pg delta cg  ugl%l
Rg pg delta cg
0.000E+00 [ #DIV/0! [ #DIV/0! [ #DIv/0! [ #DIv/0!

ge [%]
#DIV/0!
ge [%]
#DIV/0!

15 0.000€+00] 0.000£+00[0.000E+00|9.775E-02|

7 0.000€+00[ 0.000£+00[0.0008+00]9.775E-02|

Eg2 [%]
1.000+02

1.000E+02

Eg3 [%]
1.000+02

Ega[%]
1.000E+02

1.000E+02 | 1.000E+02

0.000E+00

0.000E+00

Rg pg delta cg_ g%
Rg pg delta cg
0.000E+00 [ #DIV/0! [ #DIV/0! [ #DIv/0! [ #DIv/0!

0.000E+00

ge [%]
#DIV/0!
ge [%]
#DIV/0!

Wall
Grid | Shear c
20 Stress
21
2
2
2
2

olslolslwlvlo
olololololole

27
28
2

30 c=87T/(r'U2).
E
2
3
4
35

| vaw velocity





